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CHAPTER 1

Installing PowerPath

This chapter contains the following sections:

l Before installing PowerPath............................................................................... 10
l Installation procedures........................................................................................13
l After installing PowerPath.................................................................................. 17
l Adding features to an existing installation...........................................................18
l Installing a PowerPath Service Pack for Windows............................................. 20
l Install a PowerPath patch for Windows..............................................................20
l Unsupported installation changes...................................................................... 20
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Before installing PowerPath
The sequence of steps to configure a storage system and install PowerPath or
PowerPath/VE for Windows Hyper-V on a host depends on the storage system you
use.

Note

Throughout this document, all references to PowerPath refer to PowerPath and
PowerPath/VE for Windows Hyper-V, unless otherwise noted. PowerPath/VE for
Windows Hyper-V provides the same multipathing functionality as PowerPath for
Windows in non-virtual environments, and it supports Migration Enabler.

Note

In Windows server 2016, the PowerPath 6.2 patch 01 or later installer now enforces
two restarts, when MPIO is not installed before the PowerPath installation. In
Windows 2016, the MPIO needs a restart for its configuration. PowerPath installation
can be done only after the MPIO configuration, hence two restarts are required.

Note

In Windows 2008 R2, Windows 2012 and Windows 2012 R2, Install the Windows 10
Universal CRT Update for Visual Studio 2017. The Windows 10 Universal CRT is a
Windows operating system component that enables CRT functionality on the Windows
operating system. This update allows Windows desktop applications that depend on
the Windows 10 Universal CRT release to run on earlier Windows operating systems.
You can download this update from Microsoft Support

Check array configurations
Procedure

l Check if the arrays attached are configured properly as per the array configuration
documents.

Check NetApp storage array report_scsi_name setting on page 80 provides more
information on NetApp array configuration.

Gather up-to-date information
Check the EMC Online Support website for current information.

l PowerPath documentation—EMC updates PowerPath documentation when it
releases new features with a service pack or when documentation errors are
reported.

l Service packs and upgrades—You can download PowerPath service pack
software from EMC Online Support. Determine which service packs (if any) to
install after PowerPath, and whether those service packs have any additional
installation prerequisites.

Installing PowerPath
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Choose a convenient time
Installing PowerPath requires that you restart the host.

Plan to install or upgrade PowerPath at a convenient time to minimize disruption to
the site.

Activate the license
PowerPath/VE for Windows Hyper-V and PowerPath for Windows require separate
licenses. However, the licensing process for PowerPath/VE for Windows Hyper-V is
the same as the licensing process for PowerPath for Windows.

The licensing process for both PowerPath/VE for Windows Hyper-V and for
PowerPath for Windows is described in the PowerPath Family Electronic License
Ordering Process Technical Notes, available on EMC Online Support. Take note of the
following regarding licenses:

Procedure

l If you are upgrading from an earlier version of PowerPath, you do not need to re-
register. PowerPath uses the old key.

l PowerPath Migration Enabler does not require a separate product license. The
PowerPath multipathing license includes Migration Enabler functionality for all
technology types (for example HostCopy and Open Replicator).

l Type the registration number exactly as it appears on the card or letter. To reduce
common typographical errors, the License Key field accepts either uppercase or
lowercase letters, and certain numbers and letters are interchangeable.
Specifically, an entry of the alphabetic letters O, I, S, and B is equivalent to an
entry of the numbers, 0, 1, 5, and 8.

Prepare the host and storage system
l Go to EMC Online Support and verify your environment meets the requirements

found in the PowerPath and PowerPath/VE Family for Windows Release Notes and
the https://elabnavigator.emc.com/eln/elnhome by running the Serviceability
feature of the PowerPath Management Appliance (PPMA).

l The PowerPath and PowerPath/VE Family for Windows Release Notes includes the
qualified Microsoft MPIO framework versions.

l The PowerPath and PowerPath/VE Family for Windows Release Notes includes a list
of all Microsoft Hotfixes that are required to be installed, depending on your
Windows Operating System, prior to installing PowerPath.

l Configure HBA drivers. Ensure that you follow the HBA driver configuration
guidelines outlined in the https://elabnavigator.emc.com/eln/elnhome and the
HBA vendor documentation. The use of improper settings can cause erratic
failover behavior, such as greatly increased I/O delays.

l For hosts connected to storage arrays through a Fibre Channel switch (that is, a
fabric), configure the HBAs by using persistent binding for SCSI target IDs.

l Beginning with the 6.1 release of PowerPath for Windows, all drivers are signed
with SHA256 certificates. For SHA256-signed drivers to work on Windows Server
2008 R2, Microsoft hotfixes KB2921916 and KB3033929 or their superseded KBs
needs to be installed on the server. You can check the superseded KBs on
Microsoft Support. PowerPath installer checks the existence of these KBs before
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proceeding with the installation on 2008 R2 servers. It is possible that these KBs
are superseded by subsequent Microsoft KBs. If the superseding KBs are installed
on a server, the PowerPath installer KB check may fail even if SHA-256 support is
in place. You can confirm if SHA256 support exists on the server by trying to
install both the KBs. The installation of the KBs should succeed. If it fails, the
errors indicate that the KB is already installed or is not applicable. Once you
confirm that the SHA256 support is available on the host, you can bypass the
PowerPath installer KB check by passing NO_KBCHECK=1 installer argument while
installing using the CLI.

Boot from a storage array device
The following documents provide instructions for configuring a storage array device as
the boot device:

l EMC Fibre Channel with Emulex Host Bus Adapters in the Windows Environment,
available on the Emulex website.

l EMC Fibre Channel and iSCSI with QLogic Host Bus Adapters in the Windows
Environment, available on the QLogic website.

Prepare a cluster environment
For more information on installing PowerPath in a new or existing cluster, go to 
PowerPath in an MSCS cluster on page 65 and PowerPath in a Veritas Cluster
Server on page 69

Install in virtual environments
The procedure to install PowerPath in virtual environments is the same as the
procedure to install in physical environments. You can follow the GUI or the CLI
installation procedure described in this document.

EMC supports iSCSI and Fibre Channel (FC) connections to EMC storage using the
Microsoft Software iSCSI Initiator and Microsoft Hyper-V Virtual Fibre Channel,
respectively, in a child partition. In this configuration PowerPath is supported in a child
partition to manage multiple iSCSI or FC paths. However, pass-through disks are not
supported when running PowerPath in a child partition.

Coexistence with third-party path management software
PowerPath can coexist with MPIO-based third-party path management software such
as:

l Hitachi Dynamic Link Manager (HDLM)

l HP StorageWorks Secure Path

l HP StorageWorks AutoPath XP Virtual Array

l Microsoft MPIO (native multipathing)

l Veritas Dynamic Multipathing

PowerPath cannot co-manage devices with third-party path management software.

If multiple DSMs are installed to manage devices of an array, Microsoft MPIO
framework currently does not ensure that a particular DSM will always manage such
devices. As a result, the effects of using PowerPath DSM and another third-party
DSM for managing the same array are undetermined. Further, when PowerPath
coexists with other multipathing software to manage exclusive arrays, an HBA cannot
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be shared between the two. The Microsoft MPIO documentation provides more
details.

Installation procedures
You can install using the default GUI method or through the CLI. Refer to one of the
following procedures to install PowerPath.

Note

In Windows server 2016, the PowerPath 6.2 patch 01 or later installer now enforces
two reboots when MPIO is not installed prior to PowerPath installation. In Windows
2016, the MPIO needs a reboot for it to be configured. PowerPath installation can be
done only after the MPIO configuration, hence there are two reboots

Note

You must have administrative rights to install PowerPath.

Note

UAC settings in the host should allow drivers and system softwares to be installed.

Note

PowerPath should have access to make changes to the Install directory.

l Install PowerPath using the GUI (default method) on page 13

l Install PowerPath using the CLI on page 16

PowerPath installation creates installation logs by default in %ProgramData%\EMC
\PowerPath\logs.

Service pack and patch installations
To install a PowerPath service pack or patch for Windows, see the following sections:

l Installing a PowerPath Service Pack for Windows on page 20

l Install a PowerPath patch for Windows on page 20

Install PowerPath using the GUI (default method)
Install PowerPath with the default interactive prompts.

Procedure

1. Perform one of the following:

l If the PowerPath executable file is saved on your local system, double-click
the PowerPath executable file.

l Click Start and then select Run.
In the Run window, browse to or type the name of the PowerPath
installation program:

<drive>:\<PowerPath_pkg_name>
2. Select the language for this installation from the list and click Next.

Installing PowerPath
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Localized versions of the PowerPath installer are available in Brazilian
Portuguese, Latin American Spanish, French, German, Italian, Japanese,
Korean, and simplified Chinese.

3. In the setup wizard welcome window, click Next.

4. In the Custom Setup dialog box, select the features for installation.

By default, Multipathing, Migration Enabler, Management Component, and
support for EMC storage arrays are selected. Clear unwanted default features
or select additional features (such as third-party storage arrays such as
NetApp) and then click Next.

l To select or clear features, click the arrow and select the appropriate option
from the drop-down menu:
Will be installed on local hard drive

Entire feature will be installed on local hard drive

Entire feature will be unavailable

l Click Disk Usage to view the required and available space needed to install
selected features.

l Use the Browse option to change the destination folder.

5. Click Next.

6. In case of PowerPath upgrade installation and if powermt custom file is
found, the PowerPath installer provides an option to either keep or delete the
existing powermt.custom file.

l In order for the upgrade installation to convert and keep the existing
powermt.custom file, select Keep the custom configuration file.

l If you want to delete the existing powermt.custom file, select Delete the
custom configuration file.

7. In the Ready to Install dialog box, click Install.

a. Choose whether or not to save the path specific information to the
powermt custom file.

Note

The persist path information option in the powermt custom configuration
file is set to ON when the box is checked. If HBA SCSI target persistent
binding is not enabled, set persist_path_info to off. Without HBA
persistent binding, the SCSI ID of the path persisted in the custom file may
change after actions like HBA enable/disable or a server reboot. This may
cause powermt to display misleading information. Refer to the HBA
management software documentation for information on how to enable
SCSI target persistent binding.

b. If PowerPath detects that files that need to be updated are currently in use,
select one of the following options:

l Automatically close and attempt to restart applications.

l Do not close applications (A reboot will be required.)

If PowerPath does not detect files currently in use, proceed to Step d.
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c. Click OK.

d. When prompted by the EMC Licensing Tool, type your 24-digit registration
number in the License Key field, and then click Add.

Note

l PowerPath for Windows and PowerPath/VE for Windows Hyper-V each
require a separate license. The licensing procedure is the same for each.

l When upgrading PowerPath, the existing license key is saved and no
input is required.

l To enable additional array support, enter the license keys. Migration
Enabler is enabled when you enter a valid multipathing license key.

e. Click OK.

8. In the Installation Wizard Completed dialog box, to change the Management
Component default settings, click Launch Management Component
Configuration Utility and then click Finish. The Management Component is
disabled by default.

NOTICE

If you do not launch the Management Component Configuration utility during
installation, you can configure the Management Component later by going to
Start > Programs > EMC > Configuration and selecting Management
Component Configuration.

If you launched the Management Component Configuration utility, review the
following parameters.

l Ensure that Enable PowerPath Management Component is selected. It is
selected by default.

l In the Port Number field, maintain the default and recommended port value
of 9083 or change the port value to a value between 49152 and 65535 if
another application is already using the default port (9083).

l In the Heartbeat Interval field, maintain the default value of 10 minutes or
change the heartbeat interval value to a value between 1 and 60. The
heartbeat interval be based on the number of hosts being managed.

l Click Disable Single Path Symmetrix GateKeeper Setup Warnings to
maintain the default setting if you do not want Setup errors to be reported
for Symmetrix gatekeeper devices that are configured with a single path.
Otherwise, clear the check box if Symmetrix gatekeeper devices are multi-
pathed in your data center.

Note

PowerPath supports both single-path and multi-path configured Symmetrix
gatekeepers. Consult your network administrator for more information about
your Symmetrix gatekeeper configuration.

l Click Use Windows perfmon forPowerPath PMI counters to make
PowerPath performance metrics (PowerPath counters) available in the
Windows Performance monitoring tools.
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l To restore the default options, click Restore Default.

9. Click Yes to reboot now or No to reboot later.

10. (optional) If you installed Migration Enabler, and if you are not planning to use
this feature, disable this service and change the Startup type to disabled.

11. When the host restarts, follow the instructions in After installing PowerPath on
page 17

Install PowerPath using the CLI
Install using the more advanced command line interface. Use spaces to separate
multiple properties.

Procedure

1. Type the following command syntax to install PowerPath.

<drive>:\<PowerPath_pkg_name> <install_parameters> /
v"<Property>=<Value>"

l For a silent or unattended installation, which does not require user input.

Silent installations include the /s parameters.

<drive>:\<PowerPath_pkg_name> /s /v"/L*v <logfile>
<Property>=<Value>

Note

Silent or unattended installation errors are logged in <logfile>, the
location specified in the installation command. No error message appears in
the Windows PowerPath Administrator GUI.

l For an interactive installation, which requires user input.

<drive>:\<PowerPath_pkg_name> /v"/L*v <logfile>
<Property>=<Value>

drive

The drive letter, for example, C.

PowerPath_pkg_name

The PowerPath package name. For example,
EMCPower.X64.signed.<version>.<build>.exe. Where version is
the product version. For example, PowerPath 6.2.

install_parameters

One or more parameters (/s, /v, or /p) that are described in CLI
parameters.

logfile

Creates the log file where the log message is sent, for example, C:\logs
\PPsetup.log. Ensure that the specified directory exists within the
specified path.

Property=Value

One or more optional properties that are described under the /v parameter
in CLI parameters.
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The following examples provide scenarios using the silent and interactive CLI
methods.

l Silent installation

Install all default PowerPath features (Multipathing, Migration Enabler,
Management Component, and support for EMC storage arrays) using the
silent method and to also set the PowerPath license and disable restart.

C:\EMCPower.X64.signed.<version>.<build>.exe /s /v"/L*v C:
\logs\PPsetup.log LICENSENUM=0000-0000-0000-0000-0000-0000
NO_REBOOT=1"

l Unattended installation

Install all default PowerPath features (Multipathing, Migration Enabler,
Management Component, and support for EMC storage arrays) using the
unattended method and to also set the PowerPath license and disable
restart.

Unattended installations include the /p parameter.

C:\EMCPower.X64.signed.<version>.<build>.exe /p /v"/L*v C:
\logs\PPsetup.log LICENSENUM=0000-0000-0000-0000-0000-0000
NO_REBOOT=1"

l Interactive installation

Install PowerPath using the interactive CLI method and to set the
PowerPath license, copy, and install PowerPath files to C:\Test folder,
disable restart, and install components to support Dell SC, IBM ESS, and
Hitachi storage arrays.

C:\EMCPower.X64.signed.<version>.<build>.exe /v"/L*v C:
\Install_IBM_HDS_NETAPP.log
LICENSENUM=0000-0000-0000-0000-0000-0000 INSTALLDIR=C:\Test
NO_REBOOT=1 ADDLOCAL=SC,IBM,HDS,NETAPP"

2. After installing PowerPath, restart the host and then follow the instructions in 
After installing PowerPath on page 17.

CLI parameters describes the parameters and options.

After installing PowerPath
This section describes post-installation tasks.

Verify the configuration
Verify the PowerPath configuration after installation.

Procedure

1. After the host restarts, check that PowerPath is fully configured with multiple
paths to logical devices and (if appropriate) correct zones when you start.

2. Verify if the configuration is correct.

If PowerPath sees no devices, but the devices are seen by the operating
system, then verify that the devices are configured for PowerPath support.

powermt display

powermt display dev=all
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powermt display ports

3. Save the verified configuration.

powermt save

Verify a patch installation
Once a patch is installed, it is listed as a subentry under the PowerPath entry in Add/
Remove Programs or Programs and Features.

Procedure

l Verify that the PowerPath patch appears in the list of updated programs.

n Click Show updates in Add/Remove Programs.

n Click View installed updates in Programs and Features.

Configure the PowerPath Management Pack for Microsoft Operations
Manager

You can configure the PowerPath management daemon to remotely monitor specific
PowerPath events.

This feature is available in a separate software package available on EMC Online
Support. The management daemon integrates with Microsoft Operations Manager and
allows you to retrieve license and version information from remote PowerPath hosts.
It also can generate alerts when paths or volumes remain dead for a configurable time
frame. The PowerPath Management Pack for Microsoft Operations Manager User Guide
provides more information on configuring and using the management daemon.

Adding features to an existing installation
If PowerPath is installed on your host and you want to install additional features, such
as PowerPath Migration Enabler or components to support third-party arrays, follow
one of these procedures:

Add features to an existing installation using the GUI on page 18

Add features to an existing installation using the CLI on page 19

Add features to an existing installation using the GUI
Procedure

1. Using Add/Remove Programs or Programs and Features select the installed
version of PowerPath and then click Change.

2. In the Setup wizard welcome window, click Next.

3. Select Change and click Next.

4. Select the feature that you want to install from the drop-down list.

Installing PowerPath
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Note

l A selected feature displays a hard drive icon next to it. A red X indicates that
the feature is not selected.

l The icon next to each feature name indicates the feature’s install state. Click
Help in the Custom Setup dialog box for more information about the icons.

5. Select the option to install the feature on the local hard drive and click Next.

6. Click Install.

7. Click Finish.

8. Click Yes to reboot now or No to reboot later.

Note

If the User Account Control (UAC) is configured in the Admin Approval mode,
running the PowerPath setup program to change, repair, or to uninstall
PowerPath 6.2 using Add/Remove Programs or Programs and Features
through the control panel results in multiple elevation prompts.

Note

If you are installing Migration Enabler or Management Component then a reboot
is not required. However, installing these features with any other feature
requires a reboot.

Add features to an existing installation using the CLI
Procedure

l Add features to an existing installation.

<drive>:\<PowerPath_pkg_name> /s /v"/L*v <logfile>
LICENSENUM=<license_key> NO_REBOOT=1 ADDLOCAL=<feature>"

For example, to install XtremIO and Invista, type the following command on a
single line.

C:\EMCPower.X64.signed.<version>.<build>.exe /s /v"/L*v C:\logs
\PPsetup.log LICENSENUM=0000-0000-0000-0000-0000-0000 
NO_REBOOT=1 ADDLOCAL=XTREMIO,INVISTA"

Results

When the NO_REBOOT=1 parameter is used, reboot manually after installation.

Note

If you are installing Migration Enabler or Management Component then a reboot is not
required. However, installing these features with any other feature requires a reboot.

CLI parameters describes the parameters and options.
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Installing a PowerPath Service Pack for Windows
To install a PowerPath for Windows service pack, follow the installation instructions
in:

Install PowerPath using the GUI (default method) on page 13

Install PowerPath using the CLI on page 16

Install a PowerPath patch for Windows
Before you begin

l Ensure that the PowerPath base package is installed. The PowerPath base
package must be installed on the host before you can install a PowerPath patch
for Windows. PowerPath patches for Windows are not full package installations
and will only update a specific set of files or drivers. Installation of the patch does
not change the PowerPath version.

l If the patch has fixes for additional PowerPath features (such as, Migration
Enabler), then that feature must be enabled before you install the patch for the
patch to be able to apply its fixes.

l A lower version patch can be applied on top of a higher version one (Multiple
patches can be installed and can coexist).

Alternatively, use the command line to install the patch.

<Patch.exe> /s /v"/q NO_REBOOT=1 /L*v C:\logs\Install_PP_Patch.log"

Include NO_REBOOT=1 so that you can manually restart at a convenient time.

Procedure

1. Double click the patch executable file.

2. Click Update in the Install Welcome dialog box.

3. Click Finish.

4. Click Yes to reboot the host or No to reboot later.

Unsupported installation changes
This section describes unsupported installation changes.

Uninstalling an earlier version of PowerPath without rebooting, and then installing a
newer version may cause a system crash. To avoid this issue, reboot after installing,
uninstalling, or upgrading PowerPath.

Note

When the system is not rebooted after installing, uninstalling, or upgrading
PowerPath, the operating system confuses the uninstallation of old drivers with the
installation of new drivers, causing a system panic.
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Downgrade PowerPath
If you want to run an earlier version of PowerPath, you must roll back PowerPath.

Do not try to install an earlier version of PowerPath on hosts currently running a more
recent version of PowerPath.

Procedure

1. Uninstall the newer version of PowerPath.

2. Restart the host.

3. Install the earlier version of PowerPath.
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CHAPTER 2

Configuring PowerPath

This chapter contains the following sections:

l Overview............................................................................................................24
l Adding new paths to a PowerPath logical device............................................... 24
l Adding new logical devices to the PowerPath configuration.............................. 25
l Removing paths to PowerPath logical devices................................................... 27
l Removing PowerPath logical devices................................................................. 28
l Configuring the Microsoft iSCSI Initiator for PowerPath................................... 30
l Adding PowerPath PMI counters to Windows Performance Monitor..................31
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Overview
You must reconfigure PowerPath after making configuration changes that affect host-
to-storage-system connectivity or logical device identification.

For example:

l Fibre Channel switch zone changes

l Adding or removing Fibre Channel switches

l Adding or removing HBAs or storage-system ports

l Adding or removing logical devices

l Redeploying existing logical devices

Note

If you do not reconfigure PowerPath after making configuration changes, many of
these changes are treated as unintentional, and PowerPath tries to prevent them from
affecting applications.

Many platform-specific and some PowerPath reconfiguration operations fail when the
affected logical devices are in use (either just marked alive or with I/O in progress).
This condition is noted in specific places in the procedures that follow. After any
reconfiguration, you must monitor the outcome of individual reconfiguration steps and
confirm that the resulting changes are as expected, before relying on the new
configuration. Otherwise, some paths may not be as expected.

Whenever you make any changes to the default settings, such as changing the default
load-balancing policies, then you must run the powermt save command to ensure
that the new settings persist across restart.

Note

In Windows 2K16 configurations MPIO requires a restart for it to be configured.
InstallPowerPath after the MPIO configuration. Hence, PowerPath on Windows 2K16
needs two restarts.

Adding new paths to a PowerPath logical device
This procedure adds new paths to a logical device already configured (with at least
one path) in PowerPath. This procedure can be done without interruption to running
applications on Microsoft hosts.

CAUTION

All operations must succeed for the reconfiguration to be successful. If any step
fails, resolve that issue before proceeding. Do not use the new configuration until
the entire procedure completes successfully.

Note

Path limit: Do not configure more than 32 paths per logical device.
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Procedure

1. Confirm the current configuration.

powermt display

2. Confirm the configuration of the logical devices to which new paths are added.

powermt display dev=all

3. Ensure that the number of logical devices, hardware paths, and I/O paths are as
expected. The path state should be alive for known good paths and dead for
known bad paths.

If there is a problem, correct it before proceeding.

4. Make physical path additions as required:

a. Map the logical device to additional storage-system ports.

b. Add new HBAs. For details, refer to the vendor documentation.

c. Attach cables.

d. Rezone Fibre Channel switches.

5. If using SAN Manager™, Volume Logix, or Access Logix, make new paths
available to the host using those tools.

6. Scan for hardware changes in the device manager or alternately, restart.

In some cases, the operating system may prompt for a restart after new devices
are added.

7. Reconfigure PowerPath.

8. Inspect the new PowerPath configuration.

a. Confirm the path state.

powermt display dev=all

The new paths should be displayed with a state of alive.

b. Test all paths.

powermt restore

c. Scan operating system error logs to ensure that no errors are logged against
the new paths.

9. Correct any issues that are detected.

10. Save the new configuration.

powermt save

Adding new logical devices to the PowerPath configuration
This procedure adds new logical devices (with one or more paths) to be managed by
PowerPath and applies to managed storage system classes only.

Logical devices can be added without interruption of service, since no existing
application can be using a logical device that is not yet available. After successful
configuration, new pseudo devices can be used.
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CAUTION

All operations must succeed for the reconfiguration to be successful. If any step
fails, resolve that issue before proceeding. Do not use the new configuration until
the entire procedure completes successfully.

Procedure

1. Confirm the current configuration.

powermt display

Ensure that the number of logical devices, hardware paths, and I/O paths are as
expected. The path state should be alive for known good paths and dead for
known bad paths.

2. Make logical device and physical path changes as required:

a. Create new logical devices.

b. Map logical devices to one or more storage-system ports.

c. Add new HBAs. For details, the vendor documentation provides more details.

d. Attach cables.

e. Rezone Fibre Channel switches.

3. If using SAN Manager, Volume Logix, or Access Logix, make new paths available
to the host using those tools.

4. Scan for hardware changes in the device manager. Alternately, restart.

In some cases, the operating system may prompt for a restart after new devices
are added.

5. Reconfigure PowerPath.

6. After adding LUNs to a storage group and scanning the disk via the device
manager/diskpart scan operation or through a restart, the powermt display
dev=all command may return an error count of 1 for the new LUNs.

For example, if there are 4 paths configured between the host and the array,
PowerPath displays four errors against each LUN, one error for each path.
Run the powermt restore command to reset the error count to 0.

Note

When a new path is added to the Windows host, the system restarts the
corresponding path device to complete the software installation, resulting in a
path dead message in the system log which can be ignored.

7. Inspect the new PowerPath configuration.

a. Confirm the path state.

powermt display dev=all

All paths associated with the new logical devices should be displayed with a
state of alive.

b. Test all paths to the new logical device.

powermt restore
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c. Scan operating system error logs to ensure that no errors are logged against
the new paths and logical device.

8. Correct any issues that are detected, before saving the PowerPath
configuration or using the new logical device.

9. Set PowerPath-specific options for the new logical devices, such as load-
balancing and failover policy, path modes, write throttle enablement, and
priority.

10. Reconfigure PowerPath.

11. Save the new configuration.

powermt save

12. On the host where EMC ControlCenter® is installed, refresh the ControlCenter
database device information.

The ControlCenter documentation provides more information.

Removing paths to PowerPath logical devices
This procedure removes some (but not all) paths to logical devices configured in
PowerPath.

CAUTION

Do not remove the last live path to a logical device unless you plan to remove the
logical device entirely, as data access is interrupted. If a PowerPath device is
open, powermt remove does not remove that device or the last path to that
device.

Note

Failure to follow all the steps in this procedure correctly can result in data loss and
errors that affect the operating system.

Procedure

1. Confirm the configuration of the logical devices from which paths will be
removed.

powermt display dev=all

2. Check the number of existing paths.

The path state should be alive for known good paths and dead for known bad
paths.

3. If there is a problem, correct it before proceeding.

4. Identify the physical paths to be removed or zoned out, and confirm that there
are other paths to the affected logical devices.

Otherwise, applications using those logical devices could experience I/O errors
when you proceed.

5. Identify the PowerPath HBA number that is associated with the paths to be
removed.

powermt display dev=all

In complex topologies, there can be multiple paths on an HBA.
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6. Set the mode to standby for all paths to be removed.

powermt set mode=standby

If an HBA is to be removed, specify the HBA (instead of the device) when
running powermt set mode

7. Physically disconnect the paths or logically disconnect them by removing them
from active zones.

As a result, the operating system may log some error messages. However,
PowerPath prevents these errors from affecting applications.

8. Scan for hardware changes in the device manager. Alternately, restart.

In some cases, the operating system may prompt for a restart after new devices
are added.

9. Confirm that the paths listed as dead are the ones that you intended to remove.

powermt restore

10. Remove the paths.

powermt remove

Specify both the hba and dev arguments

CAUTION

If you do not specify the hba argument, all paths to the specified logical
device are removed.

11. Remove HBAs as required and reboot if needed.

12. Inspect the new PowerPath configuration:

a. Confirm the number of paths.

powermt display

The output should show fewer total paths than before. All paths should have
a state of optimal.

b. Confirm the path state.

powermt display dev=all

All remaining paths associated with the affected logical devices should be
displayed with a state of alive.

13. Correct any issues detected before saving the PowerPath configuration or
using the new logical devices.

14. Save the new configuration.

powermt save

Removing PowerPath logical devices
This procedure removes logical devices (with all configured paths to those logical
devices) configured in PowerPath. Logical devices can be removed without
interruption of service only if no applications are using or configured to use the logical
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devices you are removing. The procedure may fail if any application is using a device
that is associated with the path to be removed.

Procedure

1. Inspect the current PowerPath configuration:

a. Confirm the current configuration.

powermt display

Ensure that the total number of logical devices, hardware paths, and I/O
paths are as expected.

Since one or more paths may have failed, not all paths may be listed as
optimal.

b. Confirm the configuration of the logical devices that are removed.

powermt display dev=all

c. Check the number of existing paths.

The path state should be alive for known good paths and dead for known bad
paths.

2. If either of the above displays indicates a problem, correct it before proceeding.

3. Identify the logical devices to be removed.

4. Identify the physical paths that also may be removed.

5. Identify the PowerPath HBA number that is associated with the paths to be
removed.

powermt display dev=all

In complex topologies, there can be multiple paths on an HBA.

6. Reconfigure all applications that are using the logical devices to be removed, so
they are no longer configured to use them.

7. Unmount file systems.

8. Remove the volume groups using the appropriate volume manager command.

9. Scan for hardware changes in the device manager. Alternately, restart.

10. If using SAN Manager™, Volume Logix, or Access Logix, remove access to the
logical devices to be removed, using those tools.

As a result of this step, the operating system may log some error messages.
These are expected and are harmless.

11. Remove the paths.

powermt remove dev=all

12. Save the new configuration.

powermt save

13. Disconnect physical paths or zone out paths with switched fabric zone changes
as required.

14. Confirm that the paths that are listed as dead are associated with the logical
devices you intend to remove.

powermt restore
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15. Depending on the type of HBA installed, scan for hardware changes in the
device manager. Alternately, restart.

In some cases, the operating system may prompt for a restart after new devices
are added.

16. Inspect the new PowerPath configuration:

a. Confirm the number of paths.

powermt display

The output should show fewer total paths than before. All paths should have
a summary state of optimal.

b. Confirm the path state.

powermt display dev=all

All remaining paths that are associated with the affected logical devices
should be displayed with a state of alive.

17. Correct any issues that are detected above, before saving the PowerPath
configuration or using the new logical devices.

18. Save the new configuration.

powermt save

Configuring the Microsoft iSCSI Initiator for PowerPath
Refer to the recommended array and hardware guidelines.

Procedure

l Select Enable multi-path while creating sessions on the target and then click
OK.

The Microsoft iSCSI initiator is available by default.

Enabling and disabling the iSCSI NIC IP display feature
The iSCSI display feature is disabled by default. To see the iSCSI NIC IP for every path
in powermt display, enable the iSCSI display feature. Enabling or disabling the
iSCSI IP display feature does not affect the iSCSI functionality. This display feature
has minimal support; PowerPath Host, which has multiple NIC IPs configured in the
same subnet, is not supported.

Before you begin

Perform the following procedure to ensure that a specific NIC IP is assigned to every
iSCSI target. Repeat the following steps for each iSCSI target in the Targets tab of
the Microsoft Software iSCSI Initiator Properties. This process ensures only one path
is dead at a time instead of all paths going dead together.

1. Select a target.

2. Click Disconnect to disconnect the target.

3. Click Connect and then click Advanced... to go to Advanced Settings.

4. Set the Local Adapter to Microsoft iSCSI Initiator. Set the Initiator IP to the
specific NIC IP from the same subnet as that of the Target IP.

5. Click Apply and OK.
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To enable and disable the iSCSI display feature:

Procedure

1. To enable the iSCSI display feature, set the following environmental variable:

set EMCPMPAPI_ISCSI_DISPLAY=1

2. To disable the iSCSI display feature, unset the environmental variable (if already
set) by running the following command:

set EMCPMPAPI_ISCSI_DISPLAY=

Adding PowerPath PMI counters to Windows Performance
Monitor

Path Management Insight (PMI) capabilities help performance monitoring by
characterizing I/O patterns and diagnosing I/O problems.

The PMI counter and timers on the Performance Monitor framework is published by
the V2 Performance Counter provider. The provider which is hosted by the
PowerPath Management Service, is part of the PowerPath Management Component
and is enabled by default. Each PMI counter and timer is present in the perfmon. Two
specific PowerPath PMI counters are displayed as part of the Windows Performance
Monitoring tools under Performance\Performance Tools\Performance Monitor. These
independent counters are also listed in the Add Counters wizard and display the
following information:

l PowerPath Volume PMI Data—contains all counters and timers for Volumes

l PowerPath Path PMI Data—contains all counters and timers for Paths

Apart from powermt set perfmon, there are two more commands that can be
used to collect insights for enhanced performance information:

l powermt display perf dev
l powermt display perf bus
The output of these commands provide:

l Read, Write, and Total Throughput

l Read, Write and All Average Response Time

l Latency Distribution

l Retry delta

l Error delta

For more information on these commands, see the PowerPath Family CLI and System
Messages Reference.

For more information on adding counters, refer to Microsoft Performance Monitoring
documentation.

Procedure

l Start collecting data.

powermt set perfmon=<on>

Setting the perfmon command to On initializes the performance monitoring
counter and measurements.
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CHAPTER 3

Upgrading PowerPath

This chapter contains the following sections:

l Before upgrading............................................................................................... 34
l Upgrade procedures...........................................................................................35
l After upgrading PowerPath............................................................................... 39
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Before upgrading
Before upgrading PowerPath or installing a service pack:

Note

You do not need to remove the previous version of PowerPath before upgrading to
PowerPath 6.x.

Procedure

1. Go to EMC Online Support and do the following:

a. Check for the most current information. EMC updates release notes
periodically and posts them on EMC Online Support.

b. Download the latest version of EMC Reports, available on EMC Online
Support, and then check the serviceability data of PowerPath Management
Appliance.

c. Download the PowerPath software on EMC Online Support at Downloads
and save it to your local directory.

Refer to https://elabnavigator.emc.com/eln/elnhome and Release Notes of the
PowerPath version to be upgraded to check for the supported arrays.

2. Save the current PowerPath configuration using one of the following methods:

l Save the latest PowerPath configuration.

powermt save
If the custom file is being saved to a non-default location, refer to the
Upgrading PowerPath custom file conversion section.

l In the Windows PowerPath Administrator GUI, right-click the root node and
then select All Tasks > Save Config as. Specify a file name and click Save.

Note

PowerPath stores configuration information in a configuration file that may
be loaded at boot time. When using the Windows PowerPath Administrator
GUI, the configuration file can be saved only under the default filename.
After a service pack is applied, the configuration file format may have
changed, resulting in the configuration file no longer being backward
compatible.

3. Stop powermt display if it is running.

4. Close the Windows PowerPath Administrator GUI if it is open.

5. Open 'services.msc' at the command prompt and verify that the below
PowerPath services are operational:

l EMC PowePath Service

l EMC PowerPath Migration Service

Note

EMC PowerPath Remote Management component service will also be running if
it was enabled in the existing PowerPath version.
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6. Check 'powermt display dev=all' to verify that there are no dead paths.

a. Fix any SAN issues that caused the dead paths.

b. If the dead paths are no longer required, remove the dead paths. The
PowerPath Family CLI and System Messages Reference provides more
information on how to remove the dead paths.

7. Verify that at least 250 MB of free space is available in the installing drive.

8. Verify that there are no active migrations pending.

9. Ensure that there are no fabric or array configurations changes in progress.

10. If upgrading to claim support for a newly added array, ensure that the
corresponding array feature is enabled. Refer to the Installation and upgrade
procedures section for information on how to enable a feature.

11. Uninstall any PowerPath hot fixes on the host. Use Add/Remove Programs or
Programs and Features to verify if hot fixes are installed.

12. Review the information in Supported upgrades on page 40.

Upgrade procedures
You can upgrade using the default GUI method or through the CLI. Refer to one of the
following procedures to upgrade PowerPath.

Note

Do not add new paths during upgrade.

Note

You must have administrative rights to install PowerPath.

Note

UAC settings in the host should allow drivers and system softwares to be installed.

Note

PowerPath should have access to make changes to the Install directory.

l Upgrade PowerPath using the GUI (default method) on page 35

l Upgrade PowerPath using the CLI on page 38

PowerPath installation creates installation logs by default in %ProgramData%\EMC
\PowerPath\logs.

Upgrade PowerPath using the GUI (default method)
Upgrade PowerPath with the default interactive prompts.

Procedure

1. Perform one of the following:

l If the PowerPath executable file is saved on your local system, double-click
the PowerPath executable file.

l Click Start and then select Run.
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In the Run window, browse to or type the name of the PowerPath
installation program:

<drive>:\<PowerPath_pkg_name>
2. Select the language for this installation from the list and click Next.

Localized versions of the PowerPath installer are available in Brazilian
Portuguese, Latin American Spanish, French, German, Italian, Japanese,
Korean, and simplified Chinese.

3. In the setup wizard welcome window, click Next.

4. In the Custom Setup dialog box, select the features for installation.

By default, Multipathing, Migration Enabler, Management Component, and
support for EMC storage arrays are selected. Clear unwanted default features
or select additional features (such as third-party storage arrays such as
NetApp) and then click Next.

l To select or clear features, click the arrow and select the appropriate option
from the drop-down menu:
Will be installed on local hard drive

Entire feature will be installed on local hard drive

Entire feature will be unavailable

l Click Disk Usage to view the required and available space needed to install
selected features.

l Use the Browse option to change the destination folder.

5. Click Next.

6. In case of PowerPath upgrade installation and if powermt custom file is
found, the PowerPath installer provides an option to either keep or delete the
existing powermt.custom file.

l In order for the upgrade installation to convert and keep the existing
powermt.custom file, select Keep the custom configuration file.

l If you want to delete the existing powermt.custom file, select Delete the
custom configuration file.

7. In the Ready to Install dialog box, click Install.

a. Choose whether or not to save the path specific information to the
powermt custom file.

Note

The persist path information option in the powermt custom configuration
file is set to ON when the box is checked. If HBA SCSI target persistent
binding is not enabled, set persist_path_info to off. Without HBA
persistent binding, the SCSI ID of the path persisted in the custom file may
change after actions like HBA enable/disable or a server reboot. This may
cause powermt to display misleading information. Refer to the HBA
management software documentation for information on how to enable
SCSI target persistent binding.

b. If PowerPath detects that files that need to be updated are currently in use,
select one of the following options:
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l Automatically close and attempt to restart applications.

l Do not close applications (A reboot will be required.)

If PowerPath does not detect files currently in use, proceed to Step d.

c. Click OK.

d. When prompted by the EMC Licensing Tool, type your 24-digit registration
number in the License Key field, and then click Add.

Note

l PowerPath for Windows and PowerPath/VE for Windows Hyper-V each
require a separate license. The licensing procedure is the same for each.

l When upgrading PowerPath, the existing license key is saved and no
input is required.

l To enable additional array support, enter the license keys. Migration
Enabler is enabled when you enter a valid multipathing license key.

e. Click OK.

8. In the Installation Wizard Completed dialog box, to change the Management
Component default settings, click Launch Management Component
Configuration Utility and then click Finish. The Management Component is
disabled by default.

NOTICE

If you do not launch the Management Component Configuration utility during
installation, you can configure the Management Component later by going to
Start > Programs > EMC > Configuration and selecting Management
Component Configuration.

If you launched the Management Component Configuration utility, review the
following parameters.

l Ensure that Enable PowerPath Management Component is selected. It is
selected by default.

l In the Port Number field, maintain the default and recommended port value
of 9083 or change the port value to a value between 49152 and 65535 if
another application is already using the default port (9083).

l In the Heartbeat Interval field, maintain the default value of 10 minutes or
change the heartbeat interval value to a value between 1 and 60. The
heartbeat interval be based on the number of hosts being managed.

l Click Disable Single Path Symmetrix GateKeeper Setup Warnings to
maintain the default setting if you do not want Setup errors to be reported
for Symmetrix gatekeeper devices that are configured with a single path.
Otherwise, clear the check box if Symmetrix gatekeeper devices are multi-
pathed in your data center.
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Note

PowerPath supports both single-path and multi-path configured Symmetrix
gatekeepers. Consult your network administrator for more information about
your Symmetrix gatekeeper configuration.

l Click Use Windows perfmon forPowerPath PMI counters to make
PowerPath performance metrics (PowerPath counters) available in the
Windows Performance monitoring tools.

l To restore the default options, click Restore Default.

9. Click Yes to reboot now or No to reboot later.

10. When the host restarts, follow the instructions in After upgrading PowerPath
on page 39

Upgrade PowerPath using the CLI
Upgrade using the more advanced command line interface. Use spaces to separate
multiple properties.

Procedure

1. Type the following command syntax to upgrade PowerPath.

<drive>:\<PowerPath_pkg_name> <install_parameters> /
v"<Property>=<Value>"
l For a silent or unattended upgrade, which does not require user input.

Silent upgrade includes the /s parameters.

<drive>:\<PowerPath_pkg_name> /s /v"/L*v <logfile>
<Property>=<Value>

Note

Silent or unattended upgrade errors are logged in <logfile>, the location
specified in the upgrade command. No error message appears in the
Windows PowerPath Administrator GUI.

l For an interactive upgrade, which requires user input.

<drive>:\<PowerPath_pkg_name> /v"/L*v <logfile>
<Property>=<Value>

drive

The drive letter, for example, C.

PowerPath_pkg_name

The PowerPath package name. For example,
EMCPower.X64.signed.<version>.<build>.exe. Where version is
the product version. For example, PowerPath 6.2.

install_parameters

One or more parameters (/s, /v, or /p) that are described in CLI
parameters.

logfile

Creates the log file where the log message is sent, for example, C:\logs
\PPsetup.log. Ensure that the specified directory exists within the
specified path.
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Property=Value

One or more optional properties that are described under the /v parameter
in CLI parameters.

The following examples provide scenarios using the silent and interactive CLI
methods.

l Silent upgrade

Install all default PowerPath features (Multipathing, Migration Enabler,
Management Component, and support for EMC storage arrays) using the
silent method and to also set the PowerPath license and disable restart.

C:\EMCPower.X64.signed.<version>.<build>.exe /s /v"/L*v C:
\logs\PPsetup.log LICENSENUM=0000-0000-0000-0000-0000-0000
NO_REBOOT=1"

l Unattended upgrade

Install all default PowerPath features (Multipathing, Migration Enabler,
Management Component, and support for EMC storage arrays) using the
unattended method and to also set the PowerPath license and disable
restart.

Unattended installations include the /p parameter.

C:\EMCPower.X64.signed.<version>.<build>.exe /p /v"/L*v C:
\logs\PPsetup.log LICENSENUM=0000-0000-0000-0000-0000-0000
NO_REBOOT=1"

l Interactive upgrade

Upgrade PowerPath using the interactive CLI method and to set the
PowerPath license, copy, and install PowerPath files to C:\Test folder,
disable restart, and install components to support Dell SC, IBM ESS, and
Hitachi storage arrays.

C:\EMCPower.X64.signed.<version>.<build>.exe /v"/L*v C:
\Install_IBM_HDS_NETAPP.log
LICENSENUM=0000-0000-0000-0000-0000-0000 INSTALLDIR=C:\Test
NO_REBOOT=1 ADDLOCAL=SC,IBM,HDS,NETAPP"

2. After upgrading PowerPath, restart the host and then follow the instructions in 
After upgrading PowerPath on page 39.

CLI parameters describes the parameters and options.

After upgrading PowerPath
This section describes post-upgrade tasks.

Verify the configuration
Verify the PowerPath configuration after upgrade.

Procedure

1. Save the configuration.

l After the host restarts, check that PowerPath is fully configured with
multiple paths to logical devices and (if appropriate) correct zones when you
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start. Check that the devices from the new arrays supported by the
upgraded PowerPath version are configured correctly.

Refer to the https://elabnavigator.emc.com/eln/elnhome and Release
Notes of the upgraded PowerPath version to check for the supported
arrays.

l Verify if the configuration is correct. If PowerPath sees no devices from the
newly supported arrays, but the devices are seen by the operating system,
then verify that the devices are configured for PowerPath support.

powermt display
powermt display dev=all
powermt display ports

Note

After PowerPath installs or upgrades, verify and save the configuration. If
you upgraded with an existing custom file, internal information in the custom
file may need to be updated with information from the new PowerPath
version. To update the custom file, run powermt save when the
configuration is verified as expected.

l Save the verified configuration.

powermt save

2. Verify that devices from arrays whose support is deprecated in the upgraded
PowerPath version will not be claimed by PowerPath. If the corresponding dead
devices are still present in the host, run powermt check force to remove
those corresponding dead paths and powermt save to save the updated
configuration information.

Refer to Release Notes of the upgraded PowerPath version to check for arrays
whose support is deprecated.

3. Verify that any new parameters added or parameter values changed in the
upgraded PowerPath version are reflected correctly. powermt display
dev=all
Refer to Release Notes of the upgraded PowerPath version to check if any new
parameters are added or if any default parameter values are changed.

Supported upgrades
Before upgrading, ensure your environment meets these requirements:

l Do not remove redundant cable connections from the array.

l Upgrading the Windows operating system on page 41 provides information on
upgrading Windows operating systems that have PowerPath installed.

l Windows Server Core 2012 and later—If PowerPath is installed through the GUI
on the core version, the license key dialog box will not appear. Use the emcpreg
utility to add the license key before rebooting.

l Upgrade using either the interactive GUI or the interactive CLI method.
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l Upgrading PowerPath in a Boot from SAN environment—You can upgrade
PowerPath in a Boot from SAN environment using the same procedure that you
would use in other environments.

Upgrade PowerPath custom file conversion
When the powermt.custom file is stored in a location other than the default location,
the custom file will not be converted when upgrading PowerPath. This may cause
error messages to appear after upgrading to PowerPath and running powermt load.

Before you begin

In order for the upgrade to convert the powermt.custom file, perform the following
procedure before beginning the upgrade.

If you upgrade PowerPath without converting the powermt.custom file, you must
recreate the settings in PowerPath 6.x.

Procedure

1. Copy the powermt.custom to the default
<PowerPath_Installation_Directory>\PowerPath directory.

2. During the upgrade, when prompted, select to keep the existing custom file.

Results

After the upgrade and restart, the settings that are saved in the powermt.custom
file will be automatically loaded.

Note

Without persistent binding, the SCSI ID of a LUN may change, leading to ghost paths
appearing during a host restart with a saved custom file configuration. This may cause
powermt to display misleading information. You may also see dead paths in case these
paths have different SCSI IDs. In such cases, you will also see more paths per LU than
what was actually configured in the SAN environment. Ghost paths can be avoided by
setting the persist_path_info to OFF. The PowerPath Family CLI and System Messages
Reference provides more information.

Note

For more information, refer to Upgrade from XtremIO version 1.05 to XtremIO version
2.2 and later on page 80.

Upgrading the Windows operating system
You can upgrade the Windows operating system to a major release (from Windows
Server 2003/2003 R2, to Windows Server 2008 R2 or later) or to its service pack.

Note

The https://elabnavigator.emc.com/eln/elnhome and the PowerPath and
PowerPath/VE Family for Windows Release Notes provide information on the required
service packs on different operating systems, supported versions of PowerPath, and
any other system information that may apply to the operating system you plan to
install.
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Upgrade to Windows Server 2008 R2 and later
When upgrading the operating system in one of the following scenarios:

l From Windows Server 2003/2003 R2 (with PowerPath installed) to Windows
Server 2008 R2 or later

l From Windows Server 2008 (with PowerPath installed) to Windows Server 2008
R2 or later

l From Windows Server 2008 R2 (with PowerPath installed) to Windows Server
2012 or later

The Windows operating system migration agent does not re-install most PowerPath
drivers during the upgrade. After the upgrade, all PowerPath functionalities are
disabled. When upgrading in a Boot from SAN environment, the operating system
upgrade may fail and the system may not restart. This issue is also documented in
Knowledgebase Solution emc221704.

Procedure

1. Remove PowerPath.

2. Upgrade the Windows operating system.

3. Install PowerPath.

Install Windows operating system service packs

Procedure

l You do not need to uninstall PowerPath before installing an operating system
service pack.
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CHAPTER 4

Removing PowerPath

This chapter contains the following sections:

l Before removing PowerPath.............................................................................. 44
l Removing PowerPath software or components................................................. 44
l Uninstalling PowerPath with Windows OS tools.................................................44
l PowerPath for Windows Patch removal.............................................................46
l PowerPath uninstallation troubleshooting..........................................................48
l Disconnecting redundant paths to the storage system...................................... 49

Removing PowerPath     43



Before removing PowerPath

Note

If you try to uninstall PowerPath when there are active migrations, the message
Migration(s) is (are) pending. Cannot uninstall. appears and the
uninstallation process aborts. Contact Customer Support if you see the message An
internal error has occurred. Migrations may be pending.

Procedure

1. Check EMC Online Support for the most current information.

EMC updates release notes periodically and posts them on EMC Online
Support.

2. Stop any application actively sending I/O.

In addition, close any remaining applications and client files to avoid warning
messages when rebooting after the uninstall.

Removing PowerPath software or components
You can remove PowerPath and all related components, or you can remove a specific
feature, such as Migration Enabler. You can also remove specific multipathing
components you may no longer need, such as components to support third-party
arrays.

Procedure

l You can use the Windows Add/Remove Programs or Programs and Features tools
to remove PowerPath, or you can use the more advanced PowerPath command
line interface.

Use one of these methods to uninstall PowerPathsoftware or features:

n Uninstalling PowerPath with Windows OS tools on page 44

n Uninstalling PowerPath using the CLI on page 46

Results

Note

Reboot after removing PowerPath.

Uninstalling PowerPath with Windows OS tools
The procedures in this section describe how to uninstall PowerPath software or
components using Windows operating system tools.

l Removing PowerPath on page 45 removes PowerPath multipathing and makes
other PowerPath features unavailable for installation changes through the
Windows PowerPath Administrator GUI. Future installation changes can only be
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made through the PowerPath executable file or the PowerPath CLI once you
complete this procedure.

l Removing PowerPath features on page 45 removes specific PowerPath
features, such as Migration Enabler, Management Component, or components
that provide support for third-party arrays.

l PowerPath for Windows Patch removal on page 46 removes specific PowerPath
patches.

Removing PowerPath
Use this procedure to completely remove PowerPath.

Procedure

1. Using Add/Remove Programs or Programs and Features uninstall the
installed version of PowerPath.

l If User Account Control (UAC) is turned on, click Yes on the elevation.

l If you belong to the Administrative group, click Allow in the elevation.

l If you are a standard user, give the administrative credentials to uninstall.

2. When prompted to remove PowerPath, click Yes.

3. When prompted to reboot the host, click No to reboot later.

You can reboot after disconnecting redundant cables.

4. Complete the steps in Disconnecting redundant paths to the storage system on
page 49

Removing PowerPath features
Use this procedure to remove specific PowerPath features.

Before you begin

Note

You cannot uninstall PowerPath multipathing for EMC arrays using this procedure.
Only the complete uninstall procedure removes default multipathing components.

Procedure

1. Using Add/Remove Programs or Programs and Features select the installed
version of PowerPath and click Change/Remove.

2. In the setup wizard welcome window, click Next.

3. Click Change.

4. To select a feature to uninstall, such as Migration Enabler or the Management
Component, click the drop-down arrow beside the feature on the Custom
Setup dialog box:
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Note

l A selected feature displays a hard drive icon next to it. A red X next to it
indicates features that are not selected.

l The icon next to the feature name indicates the install state of the feature.
Click Help in the Custom Setup dialog box for more information about the
icons.

a. Select Entire feature will be unavailable.

b. Click Next.

5. In Ready to Change EMC PowerPath 6.X.(xxbit), click Change.

6. Click Finish.

7. When prompted to reboot the host, click No to reboot later.

Feature removal (other than the Management Component) needs reboot.

Results

If you removed multipathing support for any storage systems, complete the steps in 
Disconnecting redundant paths to the storage system on page 49

PowerPath for Windows Patch removal
Uninstalling a base PowerPath package will uninstall any related patches as well. For
example, uninstallation of PowerPath 6.2 will uninstall any corresponding PowerPath
6.2 patches as well.

Uninstalling a PowerPath for Windows patch using the GUI
Procedure

1. If the PowerPath Administrator is running, close it.

2. Close all applications.

3. Open the Control Panel and then select Add/Remove Programs or Programs
and Features.

4. Display the installed PowerPath patch you want to remove by clicking Show
updates or View installed updates.

5. Select the specific PowerPath patch you want to remove, and click Remove.

6. Click Yes to remove the PowerPath patch.

7. Click Yes to restart the host.

Uninstalling PowerPath using the CLI
The command line method allows you to remove PowerPath multipathing and/or other
features, such as Migration Enabler. Use this procedure for complete PowerPath
removal or for feature-specific removal.

Procedure

1. Remove PowerPath.

l For a silent or unattended removal, PowerPath does not require user input.
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Silent removals include the /s parameters.

<drive>:\<PowerPath_pkg_name> /s /v"/L*v <logfile>
<Property>=<Value>"

Note

Silent or unattended removal errors are logged in <logfile>, the location
specified in the uninstallation command. No error message appears in the
Windows PowerPath Administrator GUI.

l For an interactive removal, which requires user input.

<drive>:\<PowerPath_pkg_name> /v"/L*v <logfile>
<Property>=<Value>"

drive

The drive letter, for example, C.

PowerPath_pkg_name

The PowerPath package name. For example,
EMCPower.X64.signed.<version>.<build>.exe. Where version is
the product version. For example, PowerPath 6.2.

uninstall_parameters

One or more parameters (/s, /v, /r, or /p) that are described in CLI
parameters.

logfile

Creates the log file where the log message is sent, for example, C:\logs
\PPsetup.log. Ensure that the specified directory exists within the
specified path.

Property=Value

One or more optional properties that are described under the /v parameter
in CLI parameters.

The following examples provide scenarios using the silent and interactive CLI
methods.

Note

Use PPREMOVE=CLEAN for complete removal of PowerPath.

l Silent removal

Remove all default PowerPath features (Multipathing, Migration Enabler,
Management Component, and support for EMC storage arrays) using the
silent removal method. It also disables reboot.

C:\EMCPower.X64.signed.6.x.<build>.exe /s /v"/L*v C:\logs
\PPremove.log NO_REBOOT=1 PPREMOVE=CLEAN"

l Unattended removal

Removes all default PowerPath features (Multipathing, Migration Enabler,
Management Component, and support for EMC storage arrays) using the
unattended uninstallation method. It also disables reboot.

Unattended installations include the /p parameter.
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C:\EMCPower.X64.signed.6.x.<build>.exe /p /v"/L*v C:\logs
\PPremove.log NO_REBOOT=1 PPREMOVE=CLEAN"

l Interactive removal

Removes components to support HP XP and Hitachi arrays and disables
restart.

C:\EMCPower.X64.signed.6.x.<build>.exe /v"/L*v C:
\Uninstall_HPXP_HDS.log NO_REBOOT=1 PPREMOVE=HPXP,HDS

l Use only in case if you encounter a problem with normal PowerPath
uninstallation (interactive/silent uninstallation).
The /r parameter replaces PPREMOVE=ALL. By default, a bootstrapper log
is created in %ProgramData%\EMC\PowerPath\logs. Adding the /L*v
<logfile> parameter does not create a log file when using the
PPRemoveAll utility.

C:\EMCPower.X64.signed.6.x.<build>.exe /r
2. After uninstalling, complete the steps in Disconnecting redundant paths to the

storage system on page 49.

CLI parameters describes the parameters and options.

PowerPath uninstallation troubleshooting
The following table lists PowerPath uninstallation troubleshooting scenarios.

Table 1 Troubleshooting scenarios

Problem Message Suggested action

Uninstalling PowerPath in a
Boot from SAN
configuration on a host that
has Windows Server 2008
R2 or later requires two host
reboots.

PowerPath cannot
disable some of its
devices because a page
file is located in a
LUN under PowerPath
control or host is
configured to boot
from SAN. Under these
scenarios, two host
reboots are required
to uninstall
PowerPath. Click OK to
proceed, or Cancel to
exit.

1. Go to Control Panel and

select Add/Remove
Programs.

2. Select PowerPath.

3. Click Remove.

4. Restart the host.

5. Repeat steps 1 through
3.

6. Restart the host.

MPIO is ready to be
uninstalled in a Boot from
SAN configuration.

PowerPath has prepared
the system for
uninstallation. You
must restart your
system and continue
with PowerPath
uninstallation.

1. Go to Control Panel and

select Add/Remove
Programs.

2. Select PowerPath.

3. Click Remove.

4. Restart the host.
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Table 1 Troubleshooting scenarios (continued)

Problem Message Suggested action

5. Repeat steps 1 through
3.

6. Restart the host.

Disconnecting redundant paths to the storage system
After uninstalling PowerPath, disconnect redundant paths to the storage system.

CAUTION

Data corruption is possible if multiple paths remain on a system after PowerPath
is removed.

Procedure

1. In the Shut Down Windows dialog box, select Shut Down from the list and then
click OK.

2. With the host shut down, disconnect the redundant cables from the HBAs to
the storage system interface ports.

Note

SAN (fabric) configurations may have multiple logical configurations per
physical connection. Ensure that no redundant zoned paths exist.

3. Restart the host.

PowerPath is completely removed from the host.
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Overview
The PowerPath Administrator graphical user interface for Windows Server consists of
two applications:

l PowerPath Monitor—Continuously monitors your PowerPath configuration and
alerts you of status changes. The PowerPath Monitor on page 52 section
provides additional information.

l PowerPath Administrator—Configures, monitors, and manages PowerPath
devices. The PowerPath Administrator on page 54 provides additional
information.

PowerPath Monitor
PowerPath Monitor (on the taskbar of the Windows desktop) continuously monitors
the status of the PowerPath configuration. PowerPath Monitor can be set to alert you
with visual and audible cues when the status changes.

For example, if a path fails, the icon changes accordingly. Depending on the
Notification settings you choose on the Options tab of the PowerPath Admin (root
node) Properties dialog box (see PowerPath Administrator online help for Windows
Server), PowerPath Monitor may:

l Sound an alarm.

l Restore the PowerPath Administrator main window.

l Flash the taskbar icon.

l Or any combination thereof.

The following table shows the taskbar icons and the status each represents.

Table 2  PowerPath Monitor taskbar icons

Taskbar icons Status

Optimal—All configured paths are operating correctly.

Degraded—Some but not all paths have failed.

All Failed—All configured paths have failed.

Server Not Responding—Cannot communicate with Monitor service.
This occurs if the PowerPath Administrator Suite encountered errors
during initialization.

PowerPath Unlicensed— PowerPath is unlicensed.

Reboot Pending—Restart the system for the configuration changes
made to PowerPath to take effect.
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Note

All non-optimal monitor icons appear only if you have selected the Flash Taskbar Icon
on the Options tab of the PowerPath Admin (root node) Properties dialog box. The
root node is the top-level view of the configuration and represents the host that
PowerPath manages.

Launching MMC with the PowerPath snap-in
You can use PowerPath Monitor to do the following:

l Launch Microsoft Management Console (MMC) with the PowerPath snap-in.

l Notify you of PowerPath status changes if you are running it on a local host.

Note

The PowerPath Administrator Monitor monitors the local host only. It does not
remotely monitor the status of another host. The icon is only present on the Windows
taskbar on the host with PowerPath Administrator installed. If you are running
PowerPath for the first time on a remote host, you must start the application
according to the instructions at Monitoring local or remote hosts with MMC on page
58

Procedure

l Perform one of the following steps.

n Double-click the PowerPath Monitor icon on the Windows taskbar to launch
the default MMC console with the PowerPath Snap-in.

n Right-click the PowerPath Monitor icon to display the following context menu
options: PowerPath Administrator (launches PowerPath Administrator) or
Close Monitor (closes the PowerPath Administrator Monitor).

PowerPath registration tools
You can use the PowerPath Licensing Tool or the emcpreg command to register
PowerPath and related products.

Adding a license using the PowerPath licensing tool
The Licensing Tool is used to register PowerPath and other products, from the
Windows GUI.

This tool allows you to add or remove licenses. For more information, see the online
help (press F1) or launch the help file, EMCLicTool.chm, from the PowerPath
software CD or the \help directory.

Procedure

l The Licensing Tool is displayed during PowerPath installation.

To manage licenses, you can launch the tool by selecting Start > All Programs >
EMC PowerPath Licensing Tool.
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Adding a license using the emcpreg command

The emcpreg command facilitates scripting options and is the only way to manage
licenses with the Windows Server Core. The emcpreg command is supported with all
supported Windows platform versions.

Procedure

l Add a license.

emcpreg -add <key>

Where <key> is the product license key.

The PowerPath Family CLI and System Messages Reference provides additional
information.

PowerPath Administrator
The PowerPath Administrator is a graphical user interface for configuring, monitoring,
and managing PowerPath devices. The PowerPath Administrator continuously
monitors a multipath storage-system environment and automatically updates the
configuration information that appears. You can use PowerPath Administrator to set
up and change your device configuration and manage physical and logical path
components.

The PowerPath Administrator displays a hierarchical representation of paths, logical
devices, and HBAs. PowerPath Administrator displays the components of a
PowerPath system as objects. PowerPath Administrator icons represent the
PowerPath objects in your configuration. The type of icon reflects the state or status
of the particular object selected. Table 6 and Table 7 display PowerPath Administrator
icons.

PowerPath Administrator panes
As part of MMC, the PowerPath Administrator has two panes:

l The scope pane displays PowerPath objects in a hierarchical list that can be
expanded or collapsed.

l The result pane provides a view of configuration statistics for PowerPath objects
selected in the scope pane.

Accessing the PowerPath Administrator device properties
You can access most of the PowerPath Administrator functions through the tabs
available in the device Properties dialog box.

PowerPath Admin (root node) properties — Use this to:

l Show root node details

l Set local or remote host options

l Set error notification options

l Set Auto-Restore

l View array management information

l Set the path latency options
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l Manage the autostandby feature options

l Manage persist_path-info option

Note

The root node is the top-level view of the configuration and represents the host that
PowerPath manages. The Root Node Properties dialog box contains the Details,
Computer, and Options tabs. (The Computer tab is present only when you are
connected to a remote host).

l Storage array properties—Show storage array details. To display this tab, select a
storage array, right-click, and click Properties.

l Storage array port properties—Show storage array port details. To display this
tab, select a storage array port, right-click, and click Properties.

l Adapter properties—Show adapter details and change modes on the adapter. To
display this tab, select an adapter, right-click, and click Properties.

l Disk properties—Show disk details, change modes on the disk, and change load-
balancing policies and priorities. To display this tab, select a disk, right-click, and
click Properties.

l Path properties—Show path details and change the mode of a path. To display
this tab, select a path, right-click, and select Properties.

Note

The previous examples illustrate the most common PowerPath Administrator
functions. The PowerPath Administrator online help for Windows Server provides
complete information on using all the PowerPath Administrator functions.

Procedure

l Right-click the EMC PowerPathAdmin root node and then select Properties.

Icons: standard, unlicensed, and unknown conditions
The following table shows icons for standard, unlicensed, unknown, and mismatched
states. Standard icons represent a configuration in which PowerPath is optimal.

Table 3 Icons on the PowerPath administrator

Object Standard
Icon

Unlicense
d Icon

Unknown
Icon

Mismatc
hed Icon

Root Node—Graphical representation
of the host and top level view of your
configuration.

N/A

Storage Array—An attached storage
system that provides logical devices
which are managed by PowerPath.

N/A

Storage Array Port—Identifies a port
within a specific storage array that
provides I/O paths to the logical
devices.

N/A
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Table 3 Icons on the PowerPath administrator (continued)

Object Standard
Icon

Unlicense
d Icon

Unknown
Icon

Mismatc
hed Icon

Disk—A logical device managed by
PowerPath. Logical devices are disk
devices presented by the storage
system.

N/A

Adapter—A device that provides an
interface between the SCSI or Fibre
Channel bus and the computer I/O bus.
An adapter can have multiple paths
associated with it.

N/A

Path—The logical or physical I/O path
from the host to the storage system,
including the HBA, cable, and interface
port.

Note

The online help provides more information on icons and their meaning.

Icons: known failure conditions
When a path fails, the failure propagates through other PowerPath Administrator
objects. These objects are displayed in a hierarchy in the scope pane and result pane.
These known failure icons represent configurations that are less than optimal.

Degraded PowerPath objects are represented by a red slash through the standard
object icon. (Because a path is either open or closed, the path icon is never shown as
degraded.) Failed PowerPath objects are represented by a red X through the standard
object icon.

The definition of degraded and failed status depends on the context shown in the
following table. For example, an unlicensed version of PowerPath with degraded or
failed paths displays icons that combine elements of both the unlicensed and degraded
icons. Unless specified otherwise, all icons display in both the summary and details
panes.

Table 4 Icons of known PowerPath failure conditions

Objec
t

Degraded Icon Failed Icon Unlicensed and
Degraded Icon

Unlicensed and
Failed Icon

Root
Node

PowerPathAdminist
rator is identifying a
degradation within
the managed
environment.

 PowerPath
Administrator is in a
failed state.

 PowerPath
is unlicensed and
identifying a
degradation within
the managed
environment.

 PowerPath
Administrator is
unlicensed and in a
failed state.

Managing PowerPath

56 PowerPath and PowerPath/VE Family for Windows 6.2 and minor releases  Installation and Administration Guide



Table 4 Icons of known PowerPath failure conditions (continued)

Objec
t

Degraded Icon Failed Icon Unlicensed and
Degraded Icon

Unlicensed and
Failed Icon

Storag
e Array  One or more

(but not all) paths
to the storage array
have failed or are in
a degraded state.

 All paths to
the specific array
have failed. This
array is not
available.

 PowerPath
Administrator is
unlicensed. One or
more (but not all)
paths to the array
have failed or are in
a degraded state.

 PowerPath
Administrator is
unlicensed. All
paths to the
specific array have
failed. This array is
not available.

Storag
e Array
Port

 One or more
(but not all) paths
to the storage array
port have failed or
are in a degraded
state.

 All paths to
the specific array
port have failed.
This array port is
not available.

 PowerPath
Administrator is
unlicensed. One or
more (but not all)
paths to the array
port have failed or
are in a degraded
state.

 PowerPath
Administrator is
unlicensed. All
paths to the
specific array port
have failed. This
array port is not
available.

Power
Path
Device

 One or more
(but not all) paths
to the disk device
have failed.

 All paths to
the specific disk
device have failed.
This disk is not
available.

 PowerPath
Administrator is
unlicensed. One or
more (but not all)
paths to the disk
device have failed.

 PowerPath
Administrator is
unlicensed. All
paths to the
specific disk device
have failed. This
disk is not
available.

Adapte
r  One or more

(but not all)
adapters have
either failed or
degraded. Displays
in the Adapters
folder in the scope
pane. One or more
(but not all) paths
have failed on the
specific adapter.

 All paths on
this adapter have
failed.

 PowerPath
Administrator is
unlicensed. One or
more (but not all)
paths have failed
on the specific
adapter.

 PowerPath
Administrator is
unlicensed. All
paths on this
adapter have
failed.

Path Not applicable

 One or more
of the hardware
components that
make up the path
has failed;
therefore, the entire
path failed.

Not applicable

 PowerPath
Administrator is
unlicensed, and
one or more of the
hardware
components that
comprise the path
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Table 4 Icons of known PowerPath failure conditions (continued)

Objec
t

Degraded Icon Failed Icon Unlicensed and
Degraded Icon

Unlicensed and
Failed Icon

has failed;
therefore, the
entire path fails.

Undefined SP conditions
The following icons represent a rare condition on active/passive arrays, including VNX
OE and CLARiiON, that produce a double link control card (LCC) failure. If you see
these icons, the LCC fault light on the VNX OE or CLARiiON array should be amber.
Refer to the VNX OE or CLARiiON documentation for troubleshooting information, or
contact Customer Support for information on replacing an LCC.

Table 5 Icons of undefined SP PowerPath failure conditions

Standard
Icon

Degraded
Icon

Failed Icon Unlicensed
Icon

Unlicensed
and
Degraded
Icon

Unlicensed
and Failed
Icon

 The
CLARiiON link
control cards
(LCC) have
failed. The SP
owning the
disk is
unknown and
the disk is
unavailable.

 The
CLARiiON link
control cards
(LCC) have
failed. The SP
owning the
disk is
unknown and
one or more
(but not all)
paths to the
disk device
has failed.
The disk is
unavailable.

 The
CLARiiON link
control cards
(LCC) have
failed. The SP
owning the
disk is
unknown and
all paths to
the disk
device has
failed. The
disk is
unavailable.

 The
PowerPath
Administrator
is unlicensed
and the
CLARiiON link
control cards
(LCC) have
failed. The SP
owning the
disk is
unknown and
the disk is
unavailable.

 The
PowerPath
Administrator
is unlicensed
and the
CLARiiON link
control cards
(LCC) have
failed. The SP
owning the
disk is
unknown and
one or more
(but not all)
paths to the
disk device
has failed.
The disk is
unavailable.

 The
PowerPath
Administrator
is unlicensed
and the
CLARiiON link
control cards
(LCC) have
failed. The SP
owning the
disk is
unknown and
all paths to
the disk
device has
failed. The
disk is
unavailable.

Monitoring local or remote hosts with MMC
With MMC and the PowerPath Snap-in, you can monitor a local host or a remote host.

Local administration— PowerPath Administrator is installed on the local host by
default. The installation process provides a preconfigured .msc file to launch the
Microsoft Management Console (MMC). Once PowerPath is installed, you can use
PowerPath to monitor the local host immediately.
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Remote administration—Part 2: Adding the PowerPath Administrator snap-in
(Remote) on page 60 provides additional information on how to add the PowerPath
Snap-in to monitor a remote host with PowerPath installed.

Procedure

l Launch MMC with the PowerPath Snap-in.

Select Start > All Programs > EMC > PowerPath > PowerPathAdmin.

Note

The path starts the PowerPath Snap-in and the MMC console on the local host with
no other action required. However, there may be scenarios in which you need to add
the PowerPath Snap-in to a new MMC console. For example, you may want to create
another instance of PowerPath Administrator on the local host or you may have
deleted the PowerPath Snap-in and want to add it again. Part 2: Adding the
PowerPath Administrator snap-in (local) on page 59 provides additional information
on how to add the PowerPath Snap-in to the MMC console to monitor a local host.

Setting a local host option
Adding the PowerPath snap-in to MMC and monitoring a local host is a two-part
procedure.

Part 1: Opening the MMC
Procedure

1. Click Start.

a. In the Start Search text box, type mmc.

b. In the Start Search text box, type cmd and then type mmc.

2. In the Open field, run mmc (32-bit OS versions) or mmc/32 (64-bit OS versions).

Note

32-bit is only available after product qualification has been requested from EMC
Online Support.

3. Click OK.

An MMC Console appears. The MMC title bar displays Console1. Within this
pane is the Console Root. Initially this folder is empty. However, once the snap-
in is added, this folder will contain the PowerPath Administrator (and any other
added snap-ins) and is displayed as expandable icons under the Console Root
folder.

Part 2: Adding the PowerPath Administrator snap-in (local)
Procedure

1. From the MMC console, select File > Add/Remove Snap-in.

2. Select PowerPath Administration and click Add.

3. Select Local Computer.
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4. Click Finish.

5. In the Add/Remove Snap-in dialog box, click OK.

PowerPath Administrator is now added to the MMC console.

Results

You can now use PowerPath Administrator to configure, manage, and monitor
PowerPath devices. Once you have changed the configuration, save the configuration. 
Saving a configuration on page 61 provides additional information.

Setting a remote host option
Adding the PowerPath snap-in to MMC and monitoring a remote host is a two-part
procedure.

Part 1: Opening the MMC
Procedure

1. Click Start.

a. In the Start Search text box, type mmc.

b. In the Start Search text box, type cmd and then type mmc.

2. In the Open field, run mmc (32-bit OS versions) or mmc/32 (64-bit OS versions).

Note

32-bit is only available after product qualification has been requested from EMC
Online Support.

3. Click OK.

An MMC Console appears. The MMC title bar displays Console1. Within this
pane is the Console Root. Initially this folder is empty. However, once the snap-
in is added, this folder will contain the PowerPath Administrator (and any other
added snap-ins) and is displayed as expandable icons under the Console Root
folder.

Part 2: Adding the PowerPath Administrator snap-in (Remote)
Procedure

1. From the MMC console, select File > Add/Remove Snap-in.

2. Select PowerPath Administration and click Add.

3. Select Another Computer.

4. Type the computer name or browse for the remote computer.

5. In the Browse for Computer dialog box, click OK.

6. Type your User Name, Domain Name, and Password.

7. Click Finish.

Note

The User Name, Domain Name, and Password fields are subsequently available
for editing from the root node Properties page if you are using MMC to monitor
a remote host. The section "Set Remote Host Options" in the PowerPath
Administrator online help provides additional information.
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8. In the Add Standalone Snap-in dialog box, click Add to add another snap-in
or click Close.

9. In the Add/Remove Snap-in dialog box, click OK.

PowerPath Administrator is now added to the MMC console.

Saving and loading Administrator settings
You can use PowerPath Administrator to configure, manage, and monitor PowerPath
devices. The first time you run PowerPath Administrator, there is a default
configuration. If you make changes, you can save them to a configuration file. The file
records the serial numbers, mode, policy, and priority for each configured path. You
can also load the last known configuration or a previously saved file.

Note

PowerPath configuration files are distinct from the PowerPath management pack
Microsoft Management Console (MMC) configuration files. If you close the MMC
window, MMC prompts you to save the MMC settings. These settings are not the
same as the PowerPath Administrator settings. Saving the MMC console settings
does not save your PowerPath configuration changes. These changes will be lost
unless you complete the following procedure.

Saving a configuration
Save the current PowerPath Administrator settings.

Note

Saving the configuration may override an existing configuration file. Provide a unique
file name and use the Save As option to avoid overriding an existing configuration file.

Procedure

l Perform one of the following steps:

n Type powermt save [file=<pathname>]
n In PowerPath Administrator, right-click the root node and select All Tasks >

Save Config as. Specify a file name and click Save.

l Save the configuration for reboot.

Loading a configuration
You can load the last known reboot state or a previously saved configuration file.

To load the last known reboot state, right-click the root node and select All Tasks >
Load Reboot Config.

Procedure

1. In the scope pane, select the PowerPath Admin root node.

2. To load a previously saved PowerPath configuration, right-click the root node
and select All Tasks > Load Config File.
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Saving MMC console settings
The MMC console enables you to display the PowerPath Snap-in data in many ways. If
you change your MMC console configuration (for example, if you resize columns,
change column displays, or change column sort order), you may want to save these
new MMC console settings.

If you close the MMC console itself, or the PowerPath Snap-in within the MMC
console, MMC prompts you with the following message:

Save console settings to <filename>.msc? 

Click Yes to save the latest console settings. By default, the MMC console settings
are saved as console1.msc in the folder:

%SystemDrive%\Programs\Administrative Tools
You can save the console settings anytime with the Console, Save menu option in the
MMC console. To save the file with a different name or to a different location, go to
MMC Console > Save As.

Deploying PowerPath with SMS
PowerPath has been qualified with the Systems Management Server (SMS) software
from Microsoft, which allows remote management of large groups of Windows-based
systems. SMS allows you to remotely manage patches, distribute software, deploy
operating systems, and perform software and hardware inventories.

Procedure

1. Create a PowerPath package in SMS.

2. Create a program for that PowerPath package.

3. Assign distribution points to that package.

4. Advertise the package to target clients by defining a collection.

See the Microsoft SMS product documentation for detailed instructions.

Windows Server traybar and UAC
The traybar monitor program communicates to the PowerPath service where it
previously communicated directly with the kernel driver. This means that if the
PowerPath service is disabled or fails to start, the traybar monitor will not function
and an error displays.

For those tasks that require administrator privileges, you receive the elevated prompt
when:

l Opening the GUI from the traybar monitor.

l Launching admin GUI from a program group.

l Starting the license tool.

When the license tool is launched from the Installation program, you do not receive an
elevation prompt.
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Note

The above information is valid only for built in administrator accounts and any
accounts which are part of the administrator group, if UAC is turned on.

Audit and error log messages
The PowerPath Family CLI and System Messages Reference on EMC Online Support
describes audit logging, including instructions for setting up logging in the
environment. It also lists error messages, descriptions, and suggested corrective
action.
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CHAPTER 6

PowerPath in an MSCS cluster

This chapter contains the following sections:

l Installing PowerPath and MSCS........................................................................ 66
l Integrating PowerPath into an existing MSCS cluster....................................... 66
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Installing PowerPath and MSCS
If you are installing PowerPath and MSCS for the first time, install PowerPath first,
and then install MSCS. Installing PowerPath first avoids disruption of cluster services
at a later time. The Microsoft MSCS documentation provides complete information on
planning, configuring, managing, and troubleshooting MSCS.

After installing PowerPath and before installing MSCS, run the emcphostid check
to check for host conflicts. If the host IDs are not unique, run the emcphostid set
command to set a unique host ID.

Note

All nodes in a cluster must have the same version of PowerPath installed. Clusters
with different hosts running different versions of PowerPath will not be supported.

Integrating PowerPath into an existing MSCS cluster
You can integrate PowerPath into an existing MSCS cluster, without shutting down
the cluster, if there is close coordination between the nodes and the storage system.

Each node in a cluster can own a distinct set of resources. Node A is the primary node
for its resources and the failover node for node B resources. Conversely, node B is the
primary node for its resources and the failover node for node A resources. The
Microsoft MSCS documentation provides complete information on planning,
configuring, managing, and troubleshooting MSCS.

Note

After installing PowerPath on the cluster, any testing involving node failover by
disconnecting all cables for a LUN or otherwise disrupting the path between the active
host and the array logs an event message in Windows. These event messages will
indicate hardware or network failure and possible data loss. If working correctly, the
cluster will failover to a node with an active path and you can ignore the messages
from the original node as logged in the event log. You should check the application
generating I/O to see if there are any failures. If there are none, everything is working
normally.

The following procedure describes how to install PowerPath on a two-node cluster.
You can also install PowerPath on clusters with more than two nodes. In these cases,
the appropriate action is noted where applicable for clusters with more than two
nodes.

To add PowerPath to an existing MSCS cluster (with MSCS running on both nodes),
follow these procedures:

l Moving all resources to node A on page 67

l Installing PowerPath on node B on page 67

l Configuring more paths between the storage system and node B on page 67

l Moving all resources to node B on page 67

l Installing PowerPath on node A on page 68

l Configuring more paths between the storage system and node A on page 68

l Returning node A resources to node A on page 68
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l Checking for host ID uniqueness (optional) on page 68

Moving all resources to node A
Procedure

1. Start the Windows Server Failover Cluster Manager Console.

2. Select all groups owned by node B.

3. Move the resources to node A.

4. Pause node B to keep the node from participating in the cluster during
PowerPath installation.

Installing PowerPath on node B
Procedure

l Install PowerPath on node B.

In a cluster with more than two nodes, install PowerPath on these other nodes.
For example, in a four-node cluster, replace node B with nodes B, C, and D as
shown in the section Moving all resources to node A on page 67.

Configuring more paths between the storage system and node B
Procedure

1. If necessary, reconfigure the storage system so its logical devices appear on
multiple ports.

2. If necessary, install additional HBAs on node B.

3. Connect cables for new paths between node B and the storage system.

4. Get the host ID.

emcphostid get

Make note of the returned PowerPath host ID for this node.

5. To resume node B, right-click node B and then click Resume.

Note

The check and the possible correction need to be performed before resuming
the node.

In a cluster with more than two nodes, configure additional paths between the
storage system and these other nodes. In case this is node C, D, and later (that
is, this is not the first installation node) and the host ID returned by
emcphostid get is not unique (matches to ID of one of the previous nodes in
this cluster), then manually change to any arbitrary value unique for this cluster
using emcphostid set.

Moving all resources to node B
Procedure

1. In the left pane of the Cluster Administrator window, select all groups.

2. Move the resources to node B.
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In a cluster with more than two nodes, move all resources to any of the
remaining nodes. For example, in a four-node cluster, replace node B with any
combination of nodes B, C, and D to which you want to move resources.

3. Pause node A.

Installing PowerPath on node A
Procedure

l Install PowerPath on node A.

Configuring more paths between the storage system and node A
Procedure

1. If necessary, configure the storage system so its logical devices appear on
multiple ports.

2. If necessary, install additional HBAs on node A.

3. Connect cables for new paths between node A and the storage system.

4. Ensure the host IDs are unique on the cluster.

emcphostid get

If the returned ID is not unique (matches to ID of one of the previous nodes in
this cluster) then manually change to any arbitrary value unique for this cluster
using emcphostid set.

5. Resume node A.

The check and the possible correction needs to be performed before resuming
the node.

Returning node A resources to node A
Procedure

1. Using the Windows Server Failover Cluster Manager, select all groups
previously owned by node A.

2. Move the resources back to node A.

Checking for host ID uniqueness (optional)
Procedure

l If emcphostid get calls, checks and possible corrections were performed
before every node was resumed, then remove host IDs that are not unique.

PowerPath in an MSCS cluster

68 PowerPath and PowerPath/VE Family for Windows 6.2 and minor releases  Installation and Administration Guide



CHAPTER 7

PowerPath in a Veritas Cluster Server

This chapter contains the following sections:

l Installing PowerPath and VCS............................................................................70
l Installing PowerPath into an existing VCS environment..................................... 70
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Installing PowerPath and VCS
Follow this procedure when installing PowerPath and Veritas Cluster Server (VCS) for
the first time. The order matters.

Procedure

1. Install PowerPath.

2. Install Veritas Cluster Server (VCS).

Results

Installing PowerPath first avoids disruption to the cluster services at a later time. The
Veritas Storage Foundation High Availability (SFHA) documentation provides
complete information on planning, configuring, managing, and troubleshooting VCS.

Note

All nodes in a cluster must have the same version of PowerPath installed. Clusters
with different hosts running different versions of PowerPath will not be supported.

Installing PowerPath into an existing VCS environment
Before you begin

CAUTION

Ensure that you follow these steps to manage the cluster environment. Failure to
do so can result in data corruption and data loss. Refer to the Veritas Cluster
Server (VCS) documentation on how to configure and manage VCS in a clustered
environment.

Procedure

1. In the Cluster Administrator window, ensure that all resources are on the
primary node in the cluster.

When the cluster resources are on the primary node, the ClusterService in the
Status View dialog box appears as online.

2. From the navigation pane on the left, right-click ClusterService and select
Disable.

This disables the secondary node in the VCS configuration.

3. Install PowerPath on the secondary node.

Follow the procedures in Installation procedures on page 13

4. Get the host ID.

emcphostid get

Make note of the returned PowerPath host ID for this node.
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Note

If this is not the first installation node and the returned host ID is not unique,
change the host ID to any arbitrary value that is unique on the cluster using the
emcphostid set command. You must perform the check and any host ID
corrections before resuming the node.

5. After installation and restart of the secondary node, right-click ClusterService
and then select Enable to re-enable the node in the VCS configuration.

6. Right-click ClusterService, select Switch to, and then select the secondary
node to move all cluster resources over to the secondary node.

7. Display the devices are in the BasicGroup and RAW group.

vxdisk list
The proper DiskType and DiskGroup information displays.

8. Once the resources are available on the secondary node:

a. Run vxassist rescan.

b. Verify that the disks are now in the proper disk group and show MBR.

vxdisk list

If there are additional nodes in the cluster configuration, repeat for each node.

Displaying DiskType and DiskGroup information
The vxdisk list command displays DiskType as RAW instead of MBR and all disks
appear to be in the default DiskGroup ‘BasicGroup’ after the installation of
PowerPath.

C:\Documents and Settings\Administrator>vxdisk list
Name     MediaName Diskgroup  DiskStyle Size(MB) FreeSpace(MB) 
Status EnclosureID     P#C#T#L#
Harddisk0          BasicGroup MBR     156327    127327     
Uninitialized DISKS@lhclu056 P0C0T0L0
Harddisk1   Disk1   dg1       RAW     10236     0          
Imported      DGC0           P2C0T0L0
Harddisk2   Disk2   dg1       RAW     10236     0          
Imported      DGC0           P2C0T1L1
Harddisk3   Disk3   dg1       RAW     10236     5118       
Imported      DGC0           P2C0T0L2
Harddisk4   Disk4   dg1       RAW     10236     5118       
Imported      DGC0           P2C0T1L3
 
C:\Documents and Settings\Administrator>vxassist rescan
Successfully rescanned

Note: Notice disk now properly show diskstyle as MBR

C:\Documents and Settings\Administrator>vxdisk list
Name      MediaName  Diskgroup  DiskStyle Size(MB) FreeSpace(MB) 
Status EnclosureID   P#C#T#L#
Harddisk0            BasicGroup  MBR      156327   127327 
Uninitialized DISKS@lhclu056 P0C0T0L0
Harddisk1   Disk1     dg1        MBR      10236    0          
Imported      DGC0           P2C0T0L0
Harddisk2   Disk2    dg1         MBR      10236    0          
Imported      DGC0           P2C0T1L1
Harddisk3   Disk3    dg1         MBR      10236    5118       
Imported      DGC0           P2C0T0L2

PowerPath in a Veritas Cluster Server

Displaying DiskType and DiskGroup information     71



Harddisk4   Disk4    dg1         MBR      10236    5118       
Imported      DGC0           P2C0T1L3

Procedure

1. Disable the primary node in the Veritas Cluster Server (VCS) configuration and
install PowerPath as described in Configuring PowerPath on page 23

2. After installing PowerPath, restart the primary node.

3. If the host IDs are not unique, set unique host IDs.

emcphostid set

4. Re-enable the node in the VCS configuration.

5. Move all cluster resources over to the primary node.

6. Once the resources are available, run vxassist rescan.

PowerPath in a Veritas Cluster Server

72 PowerPath and PowerPath/VE Family for Windows 6.2 and minor releases  Installation and Administration Guide



APPENDIX A

WHQL Certification

This appendix contains the following section:

l WHQL-certified driver........................................................................................74
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WHQL-certified driver
On Windows Server, the EMC PowerPath driver is WHQL-certified. To view the
PowerPath drive signature:

1. Select Start > Control Panel > System.

2. Click Device Manager.

3. Expand the Storage controllers node.

4. Right-click EMS device busand then select Properties.

5. Click Driver > Driver Details to see the driver signature information.

When the driver is signed, the field contains information about the organization that
signed the driver.
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APPENDIX B

Files changed by PowerPath

This appendix contains the following section:

l Files created by PowerPath installation..............................................................76
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Files created by PowerPath installation
The following files are added when PowerPath is installed on 64-bit hosts. These file
locations can change if you do not install to the default locations during PowerPath
installation. Hence <Install directory> is denoted as a variable in the following sections.

Note

All driver files (.sys, .cat, and .inf) are copied to the internal system directories
by the operating system when they are installed.

<Install directory>\PowerPath
l db_recover.exe

l db_recover.exe.intermediate.manifest

l difxapi.dll

l EmcAdminProxy.dll

l EmcAdminSvr.exe

l EmcLicTool.exe

l EmcLicTool_CHS.dll

l EmcLicTool_DEU.dll

l EmcLicTool_ESP.dll

l EmcLicTool_FRA.dll

l EmcLicTool_ITA.dll

l EmcLicTool_JPN.dll

l EmcLicTool_KOR.dll

l EmcLicTool_PTB.dll

l emcphostid.exe

l EmcpLogMsgs.dll

l EmcpMgmtComp.exe

l EmcPowerPathAdmin.dll

l EmcPowMon.exe

l EmcPowPN22.dll

l EmcPowRes.dll

l EmcPowSrv.exe

l EmcpPerfmonPmiPrvdr.dll

l emcpreg.exe

l EmcpSvcErr.dll

l emcp_lic_rtl.dll

l Emcp_mpapi_rtl.dll

l emcp_mp_rtl.dll

l emcp_serv_rtl.dll
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l Emc_PowerPath_Console.msc

l libdb51.dll

l libdb51.dll.intermediate.manifest

l Libeay32.dll

l logcon.exe

l ManagementComp_Config.exe

l mpaa.excluded

l mpaa.lams

l powerkmd.exe

l powermig.exe

l powermt.exe

l powerpath.man

l PowMigSrvc.exe

l ppinstall.exe

l pthreadVC2.dll

l server.pem

l Ssleay32.dll

<Install directory>\EMC\PowerPath\Drivers
l emcpbase.cat

l emcpbase.inf

l emcpbase.sys

l emcpclass.cat

l emcpclass.inf

l emcpclass.sys

l EmcpCoinst30.dll

l emcpdm.cat

l emcpdm.inf

l emcpdm.sys

l emcpdsm.cat

l emcpdsm.inf

l emcpdsm.sys

l emcpgpx.cat

l emcpgpx.inf

l emcpgpx.sys

l emcpmpx.cat

l emcpmpx.inf

l emcpmpx.sys
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Windows\Help
l EmcLicTool.chm

l EmcLicToolCHS.chm

l EmcLicToolDEU.chm

l EmcLicToolESP.chm

l EmcLicToolFRA.chm

l EmcLicToolITA.chm

l EmcLicToolJPN.chm

l EmcLicToolKOR.chm

l EmcLicToolPTB.chm

l EmcPowerPathAdminMMC.chm

Windows\Cluster
l ppme.dll

%ALLUSERSPROFILE%\EMC\PowerPath
l bootstrapper_*.log

l msi_*.log

l ppinstall_*.log

l vcredist_<platform>_*.log
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APPENDIX C

Configuration and parameters

This appendix contains the following sections:

l Check NetApp storage array report_scsi_name setting.....................................80
l Upgrade from XtremIO version 1.05 to XtremIO version 2.2 and later................80
l CLI parameters and properties............................................................................81
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Check NetApp storage array report_scsi_name setting
PowerPath reports NetApp ID in powermt output and in user interface only if the
Report SCSI Name String Inquiry Descriptor setting is enabled for the initiator group
through which host is connected to LUNs.

Before you begin

Procedure

1. Check the current value of the setting.

igroup show -v <initiator group name>

For example,

system1> igroup show -v <initiator group name>
<Initiator group name> (FCP):
OS Type: windows
Member: 10:00:00:00:c9:ac:58:ec (logged in on: vtic)
Member: 10:00:00:00:c9:ac:58:ed (logged in on: vtic, 1b)
UUID: 4e4eb665-fff8-11e2-98b7-123478563412
ALUA: Yes
Report SCSI Name in Inquiry Descriptor: Yes

2. Enable report_scsi_name.

igroup set <initiator group name> <report_scsi_name> yes

For a NetApp HA pair, the following property settings must be set for an
initiator group before installing PowerPath:

l The report_scsi_name property must be enabled (set to yes) for both
controllers of the pair.

l The ALUA property, set using the igroup command must be the same for
two controllers of the pair, that is, it should either be yes or no for both the
controllers.

Note

PowerPath is supported only with ALUA mode of operation for NetApp initiator
groups. For example, igroup set <initiator group name> alua yes
or igroup set <initiator group name> alua no

Upgrade from XtremIO version 1.05 to XtremIO version 2.2
and later

PowerPath provides support for either XtremIO Version 1.05 (installed as part of the
PowerPath Version 5.7 SP1 package) or XtremIO Version 2.2 and later (installed as
part of PowerPath Version 6.x package).

You can either have XtremIO Version 1.05 or XtremIO Version 2.2 and later, but not
both.
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Procedure

l If you are upgrading from PowerPath Version 5.7 SP1 to PowerPath Version 6.x,
and if generic XtremIO Version 1.05 support is installed as part of the 5.7 SP1
package.

CLI parameters and properties
Displays the full list of all available installation and removal CLI parameters and
properties. Parameters and properties can be install or removal specific as identified.

Parameters

/s

Suppresses installation and removal dialog boxes. Indicates a quiet installation and
removal (no user interaction).

/v

Directs installation to pass the specified string (enclosed in quotes) to the
Microsoft Installer (MSI). For example, /v <property>=<value>. Where
<Property> and <Value> descriptions follow.

/p

Unattended installation and removal that does not require any user interaction,
but will have installation progress bar shown. For example,

For example, during installation:

<Drive>:\<PowerPath_pkg_name> /p /v"NO_REBOOT=1"

For example, during removal:

<Drive>:\<PowerPath_pkg_name> /p /v"PPREMOVE=<feature1>, 
<feature2>, .. NO_REBOOT=1"

/r

Note

Contact EMC customer support before using /r.

Use this option only when you encounter a problem with either installation or
uninstallation of PowerPath. This invokes the PPRemoveAll utility, which removes
all PowerPath multipathing entries from the host. This /r parameter replaces
PPREMOVE=ALL.

Note

You do not need any of the above parameters with the /r parameter.
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<Property> and <Value> descriptions

/L*v<logfile>

Directs the Microsoft Installer to write verbose output to the file specified with
this option. The target directory for the log file must exist before starting a silent
installation by using the logging option (as required by the Windows installer
engine). MSI logs are also available in %ProgramData%\EMC\PowerPath
\logs.

Note

These folders may be hidden in Windows Explorer.

ADDLOCAL=<feature>

Where <feature> can be any combination of the following items. Use commas to
separate multiple entries, for example, ADDLOCAL=IBM,HDS

l If you do not pass ADDLOCAL values during command line installation, then
PowerPath multipathing, Migration Enabler, Management Component, and
support for EMC storage arrays is installed by default. If you pass ADDLOCAL
values only the features you select are installed with PowerPath multipathing.

l In the case of an upgrade, if you do not pass ADDLOCAL values during
command line installation, PowerPath installs the features based on the
previous version configuration. For example, if your previous version has
Migration Enabler, HPXP, and IBM features installed then PowerPath upgrade
selects these features for installation by default.

l ALL = Complete installation. Installs support for all PowerPath features.

l ME = Migration Enabler (selected for installation by default)

l HA = Management Component (selected for installation by default)

l IBM = IBM ESS and XIV arrays

l CELERRA = Celerra and VNXe arrays (selected for installation by default)

l HDS = Hitachi arrays

l HPXP = HP XP Active-Active arrays, and HP EVA arrays with firmware VCS
4.0 or later

l INVISTA = Invista and VPLEX arrays (selected for installation by default)

l XTREMIO = XtremIO arrays firmware Version 2.2 or later (selected for
installation by default)

l NETAPP = NetApp arrays (FAS2240)

l SC = Dell SC arrays

FORCE_DRIVER_UPDATE=1
The value 1 continues to install PowerPath and ignores the device manager check
for any pending device installation or uninstallation activities.

IGNORE_HF_WARNING=1
The value 1 sets IGNORE_HF_WARNING value to ON and continues with the
PowerPath installation even if the required Microsoft Hotfixes on the target host
are missing.
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Note

This parameter will not ignore the SHA-2 KBs (3033929 and 2921916) in Windows
Server 2008 R2 SP1 and SP2. Use NO_KBCHECK to ignore SHA-2 KBs.

INSTALLDIR=<path>
Where <path> is the location to copy and install PowerPath files. For example,
INSTALLDIR=C:\Test and INSTALLDIR=C:\Program Files\EMC

Note

The default installation directory is <RootDrive>:\ProgramFiles\EMC.

LICENSENUM=<number1,<[number2,...]>
Where <number1,<[number2,...]> must be a valid license or no license will be
saved. Use commas to separate multiple entries.

Note

PowerPath for Windows and PowerPath/VE for Windows Hyper-V each require a
separate license. The licensing procedure is the same for each.

NO_KBCHECK=1
The value 1 ignores the SHA-2 KBs check in Windows Server 2008 R2 SP1 hosts.

NO_REBOOT=1
The value 1 specifies that the host will not reboot after PowerPath is installed or
removed.

Note

Use NO_REBOOT=1 so that you can manually restart at a convenient time.

PERSIST_PATH_INFO=1
l The value 1 sets PERSIST_PATH_INFO value to ON. The default is ON.

l The value 0 sets PERSIST_PATH_INFO value to OFF.

PPREMOVE=<feature>
Specifies the features to uninstall. Use commas to separate multiple entries, for
example: PPREMOVE=ME, INVISTA

l CLEAN = Removes PowerPath and all other features, such as Migration
Enabler. It also removes driver files and corresponding registry entries.

l ME = Migration Enabler

l HA = Management Component

l IBM = IBM ESS and XIV arrays

l CELERRA = Celerra and VNXe arrays

l HDS = Hitachi arrays
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l HPXP = HP XP Active-Active arrays, and HP EVA arrays with firmware VCS
4.0 or later

l INVISTA = Invista and VPLEX devices

l XTREMIO = XtremIO arrays firmware Version 2.2 or later

l NETAPP = NetApp arrays

l SC = Dell SC arrays

PX_DELETE_CUSTOM_CONFIGURATION=KEEP|DELETE
The PowerPath installer provides an option to either keep or delete the existing
powermt.custom file through GUI or CLI methods. By default, the existing
powermt.custom file is preserved.

l KEEP keeps the existing powermt.custom file

l DELETE deletes the existing powermt.custom file

For example, the CLI method provides the parameter
EMCPower.X64.signed.<version>.<build>.exe /s /
v"PX_DELETE_CUSTOM_CONFIGURATION=DELETE NO_REBOOT=1"

UPGRADE_MPIO=1
The value 1 specifies to upgrade the existing MPIO framework. Include this
property if an MPIO version earlier than the one supported is installed.

PowerPath installation aborts if the host has a version of the MPIO framework
earlier than the supported version.

USE_BINDING_ORDER=1
The value 1 fixes incorrect IP address when performing auto host registration.

Note

When the next auto host registration is performed, the IP address of the first
adapter in the binding order list will be used.

XTREMIO_NATIVE_ONLY=1
The value 1 specifies to install support for XtremIO Versions 2.2 and later for
PowerPath Version 6.x.

This parameter is required in case of silent upgrade, when you are upgrading from
PowerPath 5.7.1 with generic XtremIO support installed to PowerPath 6.x, which
supports only XtremIO Version 2.2 and later. For example,

EMCPower.X64.signed.<version>.<build>.exe /s /v" 
XTREMIO_NATIVE_ONLY=1 NO_REBOOT=1"
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APPENDIX D

Troubleshooting installation and upgrade

This appendix contains the following sections:

l Troubleshooting PowerPath installation.............................................................86
l Repairing the PowerPath Installation................................................................. 88
l Important Knowledge Base (KB) articles............................................................89
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Troubleshooting PowerPath installation
The following table lists PowerPath installation troubleshooting scenarios.

Table 6 Troubleshooting the installation

Problem Error message Suggested action

PowerPath drivers may be
present on a host where a
PowerPath package has
been uninstalled.

Incompatible
files from a
previous
PowerPath version
exist on the
host. PowerPath
recommends
running
PPRemoveAll with
a reboot and then
proceed with the
PowerPath
installation
process. Run
PPRemoveAll now?

Perform the following:

1. Click Yes to run
PPRemoveAll.a. Otherwise,

click No and run the
PPRemoveAll utility manually.

2. Restart the host.

3. Install PowerPath.

Upgrade of PowerPath
may fail because
PowerPath drivers are
missing on the host.

PowerPath
detected a
problem that is
blocking the
upgrade. Contact
EMC customer
support for
assistance.

Perform the following:

1. Run the PPRemoveAll utility to

remove PowerPath.

2. Restart the host.

3. Install PowerPath.

Note

If the installation is still blocked,
contact your Customer Support
Representative.

Upgrade of a PowerPath
driver may fail.

The PowerPath
upgrade could not
complete.
PowerPath
recommends
running
PPRemoveAll with
a reboot and then
proceed with the
PowerPath
installation
process. Run
PPRemoveAll now?

Perform the following:

1. Click Yes to run PPRemoveAll.

Otherwise, click No and run the
PPRemoveAll utility manually.

2. Restart the host.

3. Install PowerPath.
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Table 6 Troubleshooting the installation (continued)

Problem Error message Suggested action

Installation of a PowerPath
driver may fail.

PowerPath
encountered a
problem
installing
drivers and will
roll back the
installation
changes. Contact
EMC Customer
Support for
assistance.

Contact your Customer Support
Representative.

One or more PowerPath
drivers may require a host
restart.

One or more
PowerPath drivers
require a host
reboot. Reboot
the host and then
proceed with the
PowerPath
installation
process.

Restart the host and then install
PowerPath.

One or more
PowerPath drivers
require a host
reboot. Reboot
the host, and
retry the repair.

Restart the host and then try the
driver repair again.

Repair of a PowerPath
driver fails.

The PowerPath
repair operation
could not
complete. Contact
EMC customer
support for
assistance.

Contact your Customer Support
Representative.

PowerPath failed to enable
MPIO.

PowerPath
installation
failed to enable
MPIO feature on
Windows server
2008 or later
host.

Contact your Customer Support
Representative.

Installation of PowerPath
for Windows 6.1 or later,
on Windows Server 2008
R2 fails with the following
error:

EMC PowerPath 6.1
or later requires
the following
Microsoft
hotfixes to be

Confirm if support for SHA256-
signed drivers exists on the server
by trying to install both of the KBs
listed in the error message or their
superseded KBs. You can check
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Table 6 Troubleshooting the installation (continued)

Problem Error message Suggested action

installed:
KB2921916 and
KB3033929

Microsoft Support for the
superseded KBs. The installation of
the KBs should fail with errors
indicating that the KB is already
installed or is not applicable. Once
SHA256 support is confirmed on the
host, bypass the PowerPath installer
KB check by passing
NO_KBCHECK=1 installer argument

while installing using the CLI.

a. The PPRemoveAll utility removes all PowerPath multipathing entries from the host. Use this
option only when you encounter a problem with an existing installation or try a removal.

Repairing the PowerPath Installation
After installing PowerPath if any of the PowerPath functionality is broken, you can
repair the installation to resolve those issues. The repair re-installs PowerPath and
modifies only those components of the application that are missing or broken. It also
re-installs all PowerPath drivers.

Note

Repairing PowerPath requires that you reboot the host.

Follow one of these procedures to repair PowerPath:

l Repair PowerPath installation using the GUI on page 88

l Repair PowerPath installation using the CLI on page 89

Repair PowerPath installation using the GUI
Perform one of the following steps to repair PowerPath installation through the GUI.

Alternatively, using Add/Remove Programs or Programs and Features, select the
installed version of PowerPath and click Repair.

Procedure

1. Using Add/Remove Programs or Programs and Features, select the installed
version of PowerPath and click Change.

a. In the Setup wizard welcome window, click Next.

b. Select Repair.

c. Click Repair.

d. Click Finish.

2. Click Yes to reboot now or No to reboot later.
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Note

If the User Account Control (UAC) is configured in the Admin Approval mode,
running the PowerPath setup program to change, repair, or to uninstall
PowerPath 6.2 using Add/Remove Programs or Programs and Features
through the control panel results in multiple elevation prompts.

Repair PowerPath installation using the CLI
Procedure

l Repair PowerPath.

<drive>:\<PowerPath_pkg_name> /s /v"/L*v <logfile> REINSTALL=ALL"

When NO_REBOOT=1 is used, reboot manually after installation.

For example,

C:\EMCPower.X64.signed.<version>.<build>.exe /s /v"/L*v C:\logs
\PPrepair.log REINSTALL=ALL NO_REBOOT=1"

Important Knowledge Base (KB) articles
Displays the list of Knowledge Base articles.

Table 7 Knowledge Base articles

KB number Description KB link

502458 Windows PowerPath 6.1 prerequisite
installation failed. Installation cannot
continue.

https://support.emc.com/kb/
502458

500909 How to upgrade PowerPath from 5.7.x to
6.1 in Windows Server 2008 and Windows
Server 2012 environments

https://support.emc.com/kb/
500909

500749 Running the command "powermig sync -
handle X" or "powermig cleanup -handle X"
returns an error "PPME error(79): Not all
nodes have reached the correct state to
complete this operation, please try this or
the recover command again later"

https://support.emc.com/kb/
500749

499452 How to uninstall Microsoft Visual C++
redistributables installed by PowerPath

https://support.emc.com/kb/
499452

495303 How to install PowerPath 6.1 via command
line to avoid verification of the installed
Microsoft hotfix KBs 2921916 and
3033929.

https://support.emc.com/kb/
495303

488109 What is the maximum number of luns that
can be presented, Maximum number of

https://support.emc.com/kb/
488109
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Table 7 Knowledge Base articles (continued)

KB number Description KB link

Paths per lun and Maximum size of
Partition on a Microsoft Windows
Operating System.

486378 Disks are marked offline after upgrading to
PowerPath 6.0

https://support.emc.com/kb/
486378

473972 Unable to Install PowerPath. Prerequisite
installation failed. Installation cannot
continue.

https://support.emc.com/kb/
473972

466054 Different versions of PowerPath fail to
install with error "Setup encountered a
problem while installing PowerPath.
PowerPath installation will be rolled back.
Contact EMC Customer Support for
assistance."

https://support.emc.com/kb/
466054

460124 PowerPath: Errors "RPC Server is
unavailable" during Windows start-up and
"Initialization Error" in response to
powermt command

https://support.emc.com/kb/
460124

448058 PowerPath is not able to see devices in
Windows Server 2008 or 2012. MPIO is
also unable to see devices. How to
configure Native MPIO in Microsoft
Windows Server 2008 and 2012.

https://support.emc.com/kb/
448058

335250 Behaviour of PowerPath for Windows
install, uninstall or upgrade in a Boot from
SANenvironment.

https://support.emc.com/kb/
335250
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